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ABSTRACT 

 

 

Age related macular Degeneration is a retinal condition resulting in visual 

impairment and central vision loss caused by dysfunction of the Bruch’s membrane and 

the retinal-pigmented epithelium. . A novel treatment idea proposes that these layers 

may be repaired through replacement using a synthetic Bruch’s membrane, such as 

modified poly(ethylene glycol) commonly known as PEG, allowing regrowth of the 

RPE layer in vivo or through inclusion of a functioning RPE layer when implanting the 

membrane. Modifying poly(ethylene glycol) with surface bound adhesion peptides such 

as RGDS provides an excellent biomaterial scaffold in which RPE cells may repopulate 

and regain their appropriate functions. The purpose of the proposed research is to 

evaluate the efficiency of the surface bound adhesion peptide, RGDS, and the effect of 

RGDS concentration on cellular confluency and morphology in both ARPE-19 and 

PRPE cell lines on modified PEG hydrogels. Using fluorescent and confocal 

microscopy, it was found that between 4 and 5 percent of the total coating solution was 

effectively bound to the hydrogel surface. Cellular morphology using 

immunocytochemistry staining of zonula occluden, or ZO-1, also demonstrated 

morphological characteristics are obtainable using visual parameters such as cell 

circularity.  Even though differentiation was shown to be lacking when compared to 

fibronectin controls, the results indicate that all concentrations tested proved effective 

in providing optimal cellular confluency.  
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NOMENCLATURE 

 

 

AMD -Age-related macular degeneration 

ARPE-19 –Human adult retinal pigmented epithelial cells 

BSA- Bovine serum albumin 

BlamD- diffuse drusen internal to RPE basement membrane basal laminar deposit 

BlinD- diffuse drusen external to RPE basement membrane basal linear deposit.  

CNV- Choroidal neovascularization 

DAPI- 4',6-diamidino-2-phenylindole 
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DMEM/F-12- Dulbecco’s modified eagle medium: nutrient mixture F-12  

ECM- Extracellular matrix 

FBS- Fetal bovine serum 

FGF- Fibroblast growth factor 

NVP- N-vinylpyrrolidone 

PEDF- Pigment epithelium-derived factor 

PEG- Poly(ethylene glycol) 

PEG-DA- Poly(ethylene glycol) diacrylate 

PEG-RGDS- Poly(ethylene glycol) covalently bound to peptide Arg-Gly-Asp-Ser 

PEG-RGDS-Fluor 488- PEG-RGDS fluorescently labeled with AlexaFluor 488 

PLA- poly(lactic acid) 

PLGA- poly(DL-lactic-co-glycolic acid) 

PRPE- (Primary) porcine retinal pigmented epithelial cell 

RGDS- Arginine-glycine-aspartic acid-serine (Arg-Gly-Asp-Ser) peptide 

R-P –rhodamine-phalloidin 

RPE – Retinal pigmented epithelial cell 

TEA- Triethyl amine 

ZO-1 -Zonula Occludens  
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I. INTRODUCTION 

 

 

Age-related macular degeneration (AMD) is a degenerative eye disorder that 

commonly effects people over the age of 50 (National Eye Institute, 2009). It is the 

leading cause of blindness in industrialized nations (Sun et al., 2001) This disease 

affects over 1.75 million people in the United States and is expected to increase by 50% 

by the year 2020 (The Eye Diseases Prevalence Research Group, 2004). Prevalence of 

the disease also dramatically increases with age. An estimated 8 million Americans 

over the age of 65 are at high risk to develop AMD, of which 1.3 million will develop 

the condition within the next 5 years (National Eye Institute, 2011). 

Multiple treatments are currently being developed for AMD within the field of 

bioengineering (Lee et al., 2005)(Kubota et al., 2005)(Binder et al., 2004). One 

proposed treatment removes the damaged Bruch’s membrane and replaces it with a 

synthetic scaffold, which functions similarly to the membrane extracellular matrix 

(Kubota et al., 2005). This allows introduction of a newly seeded Bruch’s membrane 

(Kubota et al., 2005) or migration of cells from the healthy portions of the retina to 

repair the diseased area (Binder et al., 2004). Of these scaffold materials, poly(ethylene 

glycol) (PEG) is currently being pursued as a potential candidate due to its desirable 

mechanical properties, ability to polymerize in situ, and inability to promote cellular 

adhesion (Gombotz, 2004). PEG also has the ability to control its density and elastic 

modulus by changing the concentration and molecular weight of the polymer, which 

allows for the material to be specifically tuned for use in repairing this tissue (Brandl et 
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al., 2007). Mann et al. (2001) demonstrated the ability to control adhesion on PEG 

hydrogels using covalently modified peptide sequences, such as RGDS, for migration 

and proliferation of smooth muscle cells; thus, enabling controlled tissue ingrowth. 

However, to date, the majority of Bruch’s membrane substitute materials developed do 

not provide the necessary signaling for controlled morphology; thus, there is a need for 

an alternative solution.  

 

A. Objective 

 

The objective of this research is to create and characterize a substitute Bruch’s 

membrane material using PEG hydrogels with varying concentrations of surface bound 

RGDS to promote adhesion of the retinal pigmented epithelial (RPE) cells while 

displaying morphology linked to a differentiated state.  

 

B. Hypothesis 

  

The hypothesis of this study is that increasing concentrations of RGDS on PEG 

hydrogels will significantly promote morphological expression, including overall cell 

coverage, cell circularity, cell area, actin filament length and actin filament orientation, 

related to RPE-specific differentiation in both adult retinal pigmented epithelial 

(ARPE-19) and primary RPE (PRPE) cell lines. This hypothesis has been evaluated by 

the completion of the objectives and specific aims listed below.  
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C. Specific Aims 

 

Specific Aim 1-1: Quantification of PEG-RGDS Coating (Fluorescence) 

PEG hydrogels were polymerized and coated with mixtures of RGDS and 

RGDS-Fluor 488 at a 10:1 ratio. Coating concentrations of 20, 10, 5 and 0 

µmol/mL were created and polymerized. Rinses from each individual gel were 

then collected and analyzed using a fluorometer. This was used to determine an 

average concentration of PEG-RGDS coating per cm2 for each coating level.  

 

Specific Aim 1-2: Quantification of PEG-RGDS Coating (Confocal) 

Also under specific aim one, RGDS-Fluor 488 coated gels were analyzed 

using confocal microscopy to further observe gel coating characteristics, 

homogeneity and deviation of the coating intensity between gel concentrations.  

 

Specific Aim 2: Quantification of Cellular Confluency on Hydrogels 

Surface coverage for PEG-RGDS hydrogels was also observed. This was 

completed using phase contrast imaging for each coating concentration, 

fibronectin control and RPE cell type. Images were analyzed using ImageJ 

(Version 1.47; NIH 2004) and compared for significant differences.  

 

Specific Aim 3: Determination of RPE Differentiation using ZO-1 Staining 

In order to observe morphological properties of the RPEs on PEG-RGDS 

coated hydrogels, each gel coating concentration, RPE line and controls were 
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stained for ZO-1 using immunocytochemistry techniques. Images were obtained 

using confocal microscopy and analyzed for circularity, area, cell perimeter and 

aspect ratio in each selected cell using ImageJ. These parameters were then used 

to compare gel groups and RPE lines to their respective fibronectin controls.  

 

Specific Aim 4: Determination of RPE Differentiation using Actin Staining 

Samples were also stained with rhodamine-phalloidin to obtain imaging of 

actin filaments within the RPEs. Cells within each image were then selected and 

analyzed using ImageJ to determine average actin filament length compared to 

each sample group. Orientation of fibronectin controls were also compared with 

the coated gels to further compare morphological properties of each group.  

 

D. Significance of Study 

 

This study is significant for a number of reasons. First, this is the one of only a 

few studies focused on using poly(ethylene glycol) modified with adhesive peptides for 

development of a synthetic Bruch’s membrane. Only one previous study based on the 

same material is known, of which is the precursor to this study (Scherzer 2010). 

Although this study is based on a previous idea, the method of material synthesis is 

novel. This study focuses on the development of surface modified PEG hydrogels 

compared to homogeneously distributed concentrations of adhesion ligands. This 

technique allows for further refinement and control of the concentrations of peptide 
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exposed, providing a more accurate quantification of the required amount of adhesive 

ligand per gel area. 

 This study is also significant in the method used to compare morphology of RPE 

cells. Using parameters based on cell staining such as circularity, area, perimeter and 

aspect ratio allows for the introduction of more quantifiable parameters to determine 

the amount of differentiation of a cell. This provides a numerical standard in which 

further studies in RPE morphology can be compared to determine the closeness of the 

confluent cell layer on the modified material to a more natural epithelial phenotype.  
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II. BACKGROUND 

 

 

A. Anatomy of The Eye 

 

The eyes are highly complex organs of the body responsible for capturing light 

and translating it into electrochemical impulses. As light enters the eye, it is focused 

using the cornea and lens. This focused light passes through the vitreous humor and is 

then projected onto the retina. At the retina, light is translated into optic nerve signals 

by rods and cones. These signals are sent from the photoreceptors to the visual cortex in 

the brain through the optic nerve and are then further interpreted into the sense of 

vision.  

 

1. General Eye Anatomy 

 

 A general anatomical representation of the eye is presented in Figure 1. The 

general anatomy of the eye consists of three primary layers. The outer layer is 

composed of the cornea, sclera and optic nerve. The cornea, along with the lens, 

refracts light and allows for the eye to focus. It is composed primarily of connective 

tissue and a thin surface epithelial layer (Shier et al., 2012). About two thirds of the 

overall refractive power of the eye comes from the cornea, due to the high refractive 

index differential from air (Guyton and Hall, 2011). The sclera is the protective fibrous 

layer composed of disorganized elastic and collagenous fibers (Shier et al., 2012). The 
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sclera also provides protection for the eye as well as an anchor point for extrinsic 

musculature. The optic nerve is located in the back of the eye and transmits signals 

from the rods and cones to the visual cortex in the brain.  

 
FIGURE 1- Eye Anatomy (Larson Eye Center, 2012) 

 

The choroid coat, ciliary body, lens and the iris form the middle layer of the eye. 

The choroid is the vascularized section of the eye, allowing for nourishment of the 

retina (Shier et al., 2012). It also contains melanocytes that absorb excess light within 

the eye. The ciliary body is the thickest part of the eye and produces aqueous humor. 

Suspensory ligaments also extend from the ciliary processes to anchor the lens into 

position. These in combination with the ciliary muscles allow for the eye to focus by 

altering the shape of the lens using tension. The lens itself lies directly behind the pupil 

and is composed of epithelial lens fibers. The iris controls the overall amount of light 

that reaches the retina. It is composed of mostly connective tissue and smooth muscle 

fibers.  

The innermost layer of the eye is the retina. This layer is the light sensitive 

portion of the eye and allows for chemical signal transmission by converting the light 

into electrochemical signals which traverse the optic nerve to the visual cortex. The 
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retina is mostly transparent to allow for absorption of light by the photoreceptors (Shier 

et al., 2012). The retina is integrated with the optic nerve and the central area of the 

retina is called the macula lutea. Within the macula lutea is the fovea centralis, which is 

the region where the sharpest vision is produced. Medial to the macula lutea is the optic 

disc, where nerve fibers from the retina join the optic nerve to transmit signals to the 

visual cortex. Central arteries and veins also pass through the optic disc.   

 The retina can be divided into nine total layers (Guyton and Hall, 2012). Starting 

from the inside of the eye is the inner limiting membrane. This layer functions as a 

barrier between the retina and vitreous humor.  The next layer is the ganglionic layer, 

which contains ganglion cells within the retina that transmit signals from the retina to 

the optic nerve.  

After the ganglionic layer is the inner plexiform layer that contains interplexiform 

cells which transmit negative feedback signals from the outer plexiform layer to the 

inner plexiform layer (Guyton and Hall 2012). This feedback mechanism is believed to 

control the spread of the visual signals by horizontal cells and control the degree of 

contrast in an image.  

Next are the inner nuclear and outer plexiform layers, which contain the nuclei of 

the majority of cell types used in the transmission of visual signals from the 

photoreceptors (Guyton and Hall, 2012). These cell types include horizontal, bipolar 

and amacrine cells. Horizontal cells specifically transmit signals horizontally from the 

rods and cones to bipolar cells. Bipolar cells transmit signals vertically from the 

photoreceptors as well as horizontal cells to ganglion or horizontal cells in the inner 

plexiform layer. Amacrine cells transmit signals in two directions, either from bipolar 
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to ganglion or horizontally within the inner plexiform layer to other amacrine cells. 

About thirty types of amacrine cells have been identified, with only about a half dozen 

of these being characterized. Each of these amacrine types plays an important role in 

visual signal stimulation, inhibition and analysis.  

The outer nuclear layer contains the bodies of the photoreceptors. Below the outer 

nuclear layer is the layer of rods and cones projecting to the pigment. Rods and cones 

are the light sensitive portion of the eye with the rods controlling both light intensity 

and black and white vision while the cones are responsible for color vision (Guyton and 

Hall, 2012). When either of these photoreceptors are excited by a light wave 

transmitted through the eye, an electrical impulse is generated which travels through the 

connected nerve fibers, described above, and to the optic nerve fibers for final 

translation into vision.  

Both rods and cones can be broken into four functional segments; the outer 

segment, the inner segment, the nucleus and the synaptic body. The outer segment 

contains most of the light sensitive photochemicals. For the rods, the photochemical is 

rhodopsin. For cones, one of three color pigments are used, all functioning in different 

spectral areas. These pigments are red (erythrolabe), green (chlorolabe) and blue 

(cyanolabe) (Shier et al., 2012).  The inner segment contains the cytoplasm and its 

respective organelles. The synaptic body connects to each of the different neuron types 

within the retina.  

Lastly, the pigmented layer prevents light reflection from within the eye via 

increased levels of melanin, allowing for clear images (Guyton and Hall, 2012). This 

layer also stores a large amount of vitamin A, used in the formation of rhodopsin.  
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2. Retinal Pigmented Epithelium 

 

Moving further through the retina, the next layer of specialized cells is the retinal 

pigmented epithelium (RPE). This layer of cells acts as a functional intermediary 

between the choroid and the neural retina (Grierson et al., 1994). RPEs are typically 

brown in color due to deposits of melanin, lipofuscin and other pigments (Lu et al., 

2001) The high concentration of these pigments allow for absorption of light, 

preventing reflection from within the eye (Mecklenburg and Schraermeyer, 2007).  The 

size of RPEs in vivo has been well documented and ranges between 10-60µm. (Roorda 

et al., 2007)(Lu et al., 2001). This number can vary significantly with age as well as 

location. Cells near the macula, the central portion of the eye, typically size within the 

10-14µm range while the periphery has been measured up to 60µm (Lee et al., 2007).  

This epithelial layer is intimately attached to the outer segment tips of the 

photoreceptors on its apical side while the basal sides rest on a basement membrane 

formed above the Bruch’s membrane (Grierson et al., 1994). RPEs are polarized and 

involved in multiple activities vital to visual function, such as phagocytosis of used rod 

and cone outer segments, metabolizing vitamin A, transporting metabolites and forming 

the blood-retinal barrier (Grierson et al., 1994). Each RPE cell supports approximately 

40 photoreceptors by transporting cellular metabolites as well as nutrients from the 

choricocapillaris (Forrester et al., 2002).  

In order to form a functional blood-retinal barrier, zonula occluden, commonly 

known as tight junctions are formed between RPE cells to prevent leakage through the 

intercellular spaces (Grierson et al., 1994). Another essential junction includes zonulae 
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adherens, or intermediate junctions, which promote adhesive properties and 

maintenance of the polygonal shape of RPEs as well as help organize the superficial 

web of actin microfilaments (Sandig and Kalnins, 1988). Gap junctions allow for low-

resistance pathways of ions and metabolites between the cells (Hudspeth and Yee, 

1973). Actin structure also plays an important role in the morphology of RPE cells. 

Actin is involved in many cellular processes, including establishing morphology, 

migration, organelle transport, cellular division and support of cell-cell junctions (Karp 

et al., 2008). Actin distribution is commonly used for evaluation of RPE morphology 

(Burke et al., 2008). This is due due to its circumferential orientation around epithelial 

RPE cells (Lee, Fishman and Bent, 2007). Re-organization of RPE cells from a 

migratory to epithelial state includes reorganization of actin filaments into peripheral 

bands (Burke et al., 2008). 

These cells are derived from the neuroepithelial cells of the neural plate during 

development and transdifferentiation into neuroretinal tissue is rapidly lost in 

mammals, although fibroblast growth factor (FGF) has been shown to stimulate 

neuroretinal regeneration in chick embryos (Grierson et al., 1994). Interestingly 

enough, RPE have been shown to transdifferentiate past development in salamanders as 

iris or lens epithelium. (Grierson et al., 1994). Not only do RPEs contribute to the 

formation of the Bruch’s membrane, but also to the development of the scleral coat 

(Grierson et al., 1994). Photoreceptor outer segments have also shown not to develop 

until contact between the neural and epithelial layers are established by the RPE 

(Hollifield and Witkovsky, 1974). 



 

12 

 

RPE cells are extremely limited in replicative ability in situ. It is believed that 

inhibition is caused by the gap junction system (Grierson et al., 1994). Since these cells 

are suspended in proliferation by contact inhibition, RPE expansion depends on the 

enlargement of individual cells. This is especially the case around the periphery, where 

multi-nucleated RPE cells can measure up to 60 µm in diameter compared to the typical 

14 µm (Grierson et al.,1994). Once contact inhibition is removed due to injury, 

proliferation of the RPE layer will resume. 

Two phenotypic styles of RPEs can form following injury. One form resembles 

morphology of a large macrophage while the other is elongated, bipolar and fibroblastic 

(Grierson et al., 1994). Macrophage forms are typical in cases of proliferative 

vitroretinopathy (PVR) and inhabit the vitreal cavity. These phenotypic expressions in 

altered circumstances rapidly revert to an epithelioid phenotype, meaning the changes 

in morphological properties is only metaplasia (Grierson et al., 1994). Once regions of 

high density and tight packing are obtained, gap junctions form between the adjacent 

cells. Extracellular matrix (ECM) materials are also synthesized, such as fibronectin 

(Grierson et al., 1994). Although RPEs may revert back to epithelioid morphologies, 

establishing an effective mosaic proves to be more difficult both in vitro and in vivo. In 

culture, RPEs often lose pigmentation and do not usually re-pigment until weeks post 

confluency (Burke et al., 2008). This extended restructuring process is also seen in N-

cadherin formation at cell-cell junctions (McKay et al., 2007). Both N-cadherin and E-

cadherin concentrations were shown to be consistent between fibroblastic and epithelial 

phenotypes, but were reorganized depending on the morphology (McKay et al., 2007). 

When observing changes in actin structures, settled RPEs produce a diffuse pattern 
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around the periphery while migratory forms produce filamentous fibers and finally 

organized stress fibers when stationary. Stress fibers are also common of normal RPEs 

in situ as well as in immobile, adherent cells in vitro (Grierson et al., 1994). Cytokeratin 

expressions also change dramatically during morphological changes. In situ, RPE cells 

express K8 but lack larger forms such as K18 and K19, yet these are expressed by 

migratory fibroblastic RPEs (Grierson et al., 1994).   

Substrate seems to be a crucial role in determining the morphological response of 

RPEs. The macrophage phenotype has been shown to develop when placed in an 

aqueous environment, photoreceptor debris, in the subretinal space or on loose collagen 

fibrils in the vitreous (Grierson et al., 1994). The fibroblast form typically generates on 

two-dimensional surfaces at low densities and when the surface is rich in fibronectin. 

This is known from studies of epidermal repair where fibronectin is abundant while 

cells are migratory, whereas laminin becomes the dominant protein after repair. Under 

crowding conditions and in the absence of fibronectin, an epithelioid type is readily 

adopted (Grierson et al., 1994). Maintenance of polarization also seems to be reinforced 

by metabolite transport and phagocytosis. Retinoids may also have growth-inhibiting 

properties as well as indirect influence on cytoskeletal structure (Grierson et al., 1994). 

 

 

3. Bruch’s Membrane 

 

The Bruch’s membrane is an integral part of the eye. This cellular basement 

membrane is a pentalaminar structure composed of a central elastin layer with 



 

14 

 

collagenous zones on both sides, forming a 2-4µm thick boundary layer between the 

RPE layer and the choroid (Lee et al., 2006). Its main function is to transport nutrients 

from the blood supply to the RPE layer and allow for removal of waste products back 

to the choricocapillaris. This layer also plays an integral part in maintaining the blood-

retinal boundary and increasing the stability of the neighboring layers (Aisenbrey et al., 

2006).  

In general, the Bruch’s membrane is predominantly composed of glycoproteins, 

much like most basement membranes. The overall glycoprotein composition of the 

membrane includes collagen I and IV, laminin, fibronectin and elastin (Marshal et al., 

1998). This combination of glycoproteins also plays in integral role in the signaling and 

polarization of the RPE layer (Grierson et al., 1994).The Bruch’s membrane is also 

ultrastructurally and biochemically similar to other membrane complexes such as the 

glomerulus, lung alveoli and other endothelial-epithelial juxtapositions (Sheridan et al., 

2004).  

The surface of the Bruch’s membrane closest to the RPE layer is known as the 

RPE basal lamina. This layer functions as the attachment surface for the RPE layer (Del 

Priore, Tezel and Kaplan, 2006). Removal of the basal lamina and the inner 

collagenous layer from the Bruch’s membrane due to disease or damage has been 

shown to prevent re-epithelialization by RPEs, making resurfacing of aged Bruch’s 

membranes difficult (Del Priore, Tezel, Kaplan, 2006). 

It is at the Bruch’s membrane that the introduction of multiple factors such as 

drusen accumulation and vascularization begins to occur, causing blurred and distorted 

vision. This indicates the initiation of a disease referred to as macular degeneration. 
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FIGURE 2- Bruch’s Membrane in relation to RPEs and choroid (Luthert 2010) 

 

B. Macular Degeneration 

 

Age-related macular degeneration is one of the most significant causes of central 

vision loss and blindness in industrialized countries (Ma et al., 2009). Although this 

disease has been studied extensively, some of the pathological changes associated with 

initiating the disease are still not fully understood. The disease in general causes central 

vision loss related to aberrations between the RPE and the Bruch’s membrane. This loss 

in central vision is due to progression of the disease within the macula lutea.  Diagnosis 

of the disease is usually conducted using a visual acuity test such as an Amsler grid 

(Doheny Eye Institute, 2007). Missing lines, distortions or blurred vision when using an 

Amsler grid can be indicators of AMD.  
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FIGURE 3- Amsler grids. Left photo indicates normal vision while the right simulates AMD. 

(National Eye Institute 2009) 

 

1. Pathology 

 

There are two predominant forms of AMD; the wet and dry form. The wet form 

of AMD, also known as exudative AMD, consists of formation of new blood vessels 

between RPEs and the Bruch’s membrane and a loss of RPE cells (Lee et al., 2006).  

This is known as choroidal neovascularization (CNV). CNV is thought to be the cause 

of 90% of the visual impairment tied to AMD (Del Priore et al., 2006) and leads to 

scarring of the retina, preventing re-epithelialization by the RPE. Dry AMD, known as 

geographic atrophy, is linked to the natural thinning of the macula over time (Luthert et 

al., 2010).  

When dysfunction of the RPE layer begins, degradation of photoreceptor waste 

products may begin to decrease, leading to drusen accumulation (Zarbin et al., 1998). 

Both drusen and CNV separate the basal lamina from the inner collagenous layers, 

distorting the RPE and photoreceptor layers above, causing visual impairment (Del 

Priore, Tezel, Kaplan, 2006). This increase in the Bruch’s membrane thickness leads to 
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a reduction in permeability, further inhibiting metabolite removal and nutrient diffusion 

(Lee, Vroom, Fishman and Bent, 2006). Drusen formation may also increase the risk 

and progression of CNV (Del Priore, Tezel, Kaplan, 2006). This drusen formation is 

often found in the inner collagenous layer as well as the basal lamina of the Bruch’s 

membrane (Del Priore, Tezel, Kaplan, 2006).  

Drusen are categorized by size and shape (Mecklenburg and Schraermeyer, 2007). 

Hard drusen typically less than 125 µm wide and are well defined; soft drusen is 

typically more diffuse, less defined visually and carry a higher risk of progression of 

AMD (Luthert et al., 2010). Hard drusen appear to contain a dendritic cell process, 

have well defined edges and appear more frequently between the choricocapillaris and 

capillaries.  Due to use of conflicting terminology in past publications concerning 

diffuse deposits, more recent categorizations based on location have been created. 

These categories are based on deposits internal to the RPE basement membrane laminar 

deposit (BlamD) and those external to the RPE basement membrane linear deposit 

(BlinD). BlamD contains abundant ‘long-spaced collagen’ similar to type VI collagen 

while BlinD contains more membranous material (Luthert et al., 2010).  

Growth factors may also play an important role in the progression (and potential 

inhibition) of AMD. Pigment epithelium-derived factor (PEDF) and Thrombospondin-1 

(TSP-1) are produced by highly differentiated RPEs and are potent inhibitors of 

angiogenesis (Ohno-Matsui et al., 2001) (Miyajima-Uchida et al., 2000). Vascular 

endothelial growth factor (VEGF), a pro-angiogenic growth factor, has also been shown 

to be produced by RPE cells on their basal side in vivo (Blaauwgeers et al., 1999). With 

RPEs and the Bruch’s membrane in their natural forms, secretions of these growth 
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factors allow for physiological maintenance of the choroid. Damage such as oxidative 

stress may cause overexpression of growth factors by the RPEs, causing a pro-

inflammatory response and a destruction of the Bruch’s membrane (Koh, 2000).  

Hypoxia may also play a role in the development of CNV. Hypoxia markedly 

increases VEGF secretion, increasing the drive of CNV and causing a positive feedback 

mechanism (Blaauwgeers et al., 1999). A decrease in Bruch’s membrane permeability 

due to age or drusen accumulation may also decrease the concentration of VEGF 

exposed to the choricocapillaris, resulting in vascular atrophy (Schlingemann et al., 

2004).  

Proper diagnosis can also become a complication for early stages of AMD, as it 

can be difficult to distinguish normal aging and pathologically significant physiological 

changes. Differences between normal ECM debris and drusen can be difficult to 

differentiate between (Del Priore et al., 2006). Normal physiological changes related to 

aging such as increasing thickness, deposition of ECM compounds and protein cross-

linking may be indistinguishable from early stages of AMD (Gullapalli et al., 2005). On 

order to appropriately diagnose early AMD, further research must occur in order to 

accurately distinguish the disease state from the normal aging process.  

 

2. Current Treatments 

 

Relatively few treatments have been proven effective for treating wet AMD. One 

of the most commonly used is that of anti-VEGF treatments. Of these, ranibizumab, 

bevacizumab and aflibercept are the most common and approved by the FDA. 
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Ranibizumab, also known as Lucentis, is commonly used for treatment of wet AMD, 

diabetic macular edema and macular edema following retinal vein occlusion. 

Ranibizumab is a monoclonal antibody fragment that binds to the receptor binding 

domain of all isoforms of VEGF-A (Browning et al., 2012). During clinical trials, 

ninety-four percent of patients maintained their current vision while almost thirty-four 

percent experienced an increase in visual acuity within one year given monthly doses 

(Rosenfield et al., 2006). Bevacizumab, also known as Avastin, is also a monoclonal 

antibody similar to ranibizumab, but uses a full-length antibody instead (Browning et 

al., 2012). Aflibercept, known as Eylea, is a newer anti-VEGF drug to come to the 

market which specifically binds to VEGF-A, VEGF-B and placental growth factors 1 

and 2 and is reported to have a higher binding affinity than both ranibizumab and 

bevacizumab (Browning et al., 2012). 

Another treatment for exudative AMD is thermal laser coagulation, which only 

restricts the progression of the disease rather than treating it (Del Priore et al., 2006). 

Unfortunately, this treatment also causes undesirable side effects such as scotoma due 

to destruction of the retinal tissue around the treatment area. Also, using this treatment 

method does not prevent further CNV from occurring in a large number of patients (Del 

Priore et al., 2006). Brachytherapy in combination with anti-VEGF medications have 

also been studied (Avila et al., 2009). This treatment used a single strontium-90 

radiation treatment along with two injections of bevacizumab and was able to obtain 

similar results as monthly doses of anti-VEGF medications alone (Avila et al., 2009). 

Side effects for this treatment included CNV leakage in one fifth of patients as well as 

cataracts in a quarter of patients. In general, all of these treatments are used to prevent 
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progression of the disease. Further research in the development and progression of the 

disease must be done in order to develop a restorative treatment. 

In addition to treatments for AMD, education on potential preventative measures 

is highly important, especially for those that may have a significant risk of developing 

the disease. Many dietary supplements such as lutein, vitamins C and E, zinc, 

glutathione and zeaxanthin are thought to be helpful in preventing early onset of CNV 

associated with AMD (Nowak et al., 2006). Smokers have also been found with 

significantly less macular pigment, leading to a risk increase by a factor of two to three 

times (de Jong et al., 2006). Omega-3 fatty acid intake has also been associated with a 

lower risk of AMD (Ambati et al., 2012). Even though taking these supplements may 

help reduce the risk of developing the disease, none of these treatments are proven to 

prevent the disease.  

In developing restorative treatments for the disease, multiple maculoplasty 

techniques have been tested to reintroduce functional RPEs to an excised or repaired 

section of Bruch’s membrane. These techniques use either transplantation, 

translocation, stimulation or cell proliferation to repair the damaged membrane (Del 

Priore et al., 2006). Submacular surgeries including membranectomies have shown 

some progress in past studies, but RPEs often showed incomplete resurfacing as well as 

choricocapillaris atrophy in areas absent of RPE.  

Currently, there have been limited successes with direct injection or 

transplantation of RPE sheets into the eye to repair damaged Bruch’s membranes 

(Binder et al., 2004). Often after transplantation, multilayered sheets of RPE cells have 

formed, developing an improper orientation of cells with respect to the photoreceptors. 
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Even with proper orientation, RPE adhesion may be lacking (Del Priore and Tezel, 

1998). Patients must also be immunosuppressed to allow for allogenic cellular grafting 

(Jiang and Jorquera, 1994). Patients with subfoveal membranectomies and 

transplantations of adult human RPEs, even with immunosuppression, have had limited 

success (Kaplan and Del Priore, 1998).  

RPE monolayers have also been suggested for transplantation into excised areas. 

By using temperature responsive materials, sheets of confluent RPE cells were obtained 

(Kubota et al., 2006). Due to the thin nature of the material, most sheets obtained some 

damage during removal from culture. Although this study proves the feasibility of 

generating these cell sheets, further research is still needed on creating more robust and 

transplantable sheets while maintaining viability and function in vivo.  

Biodegradable polymers have also been proposed as a replacement for damaged 

Bruch’s membrane. Materials such as poly(lactic acid) (PLA) and poly(DL-lactic-co-

glycolic acid) (PLGA) have been proposed as suitable membrane replacements due to 

their biocompatibility and degradability (Lu et al., 2001). In theory, cells would be 

seeded onto thin sheets of the material in vitro and allowed to reach confluency. The 

sheet would then be loaded into a micropipette and carefully injected into the damaged 

area. Cells would then attach themselves to the existing Bruch’s membrane after 

degradation of the material at two to three weeks (Lu et al., 2001). Due to the fragile 

nature of the RPE monolayer, it may be difficult to transplant a complete monolayer of 

these cells using this technique. This technique also assumes that the remaining RPE 

layer would inherently attach to the remaining Bruch’s membrane, although previous 

studies have not shown much success (Del Priore et al., 2006) (Gullapali et al., 2005).  
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A variety of other materials have been suggested as replacement for Bruch’s 

membrane such as collagen films, Bruch’s membranes from cadavers, anterior lens 

capsule, Descemet’s membrane and amniotic membranes (Lee et al, 2007). Although 

many different substrates have been proposed, no material studied so far has been able 

to successfully produce a fully functioning membrane for replacement.  

 

3. Proposed Solution 

 

In developing new treatments for AMD, it is important to understand that the 

replacement Bruch’s membrane must be of comparable thickness, similar permeability 

and provide an effective cellular scaffold in which to support the native RPE layer (Lee 

et al., 2006). The material must also be a permanent replacement for the native Bruch’s 

membrane, providing enough similar mechanical and chemical responses as to allow 

the RPE layer above to maintain a functioning membrane. The replacement membrane 

could also potentially provide chemical cues such as VEGF to sustain the 

choricocapillaris until a functioning RPE layer is obtained.  

The concept this research is based upon focuses on the development of a 

permanent, synthetic Bruch’s membrane. This synthetic membrane would mimic the 

natural functions of the Bruch’s membrane such as adequate permeability for the 

diffusion of nutrients and metabolites, comparable mechanical strength as well as 

biological molecules to promote RPE adhesion and differentiation. (Del Priore et al., 

2006). PEG hydrogels meet the requirements for a suitable membrane in these areas, 

but it is known for its poor ability for cell adhesion. In order to alleviate this problem, 
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PEG gels modified with adhesion ligands on the surface layer have been developed to 

provide cellular adhesion to the apical side of the gel. With proper concentrations of 

ligands, these gels would allow for adequate adhesion of RPE cells to promote 

confluent coverage as well as appropriate epithelial morphology. This research is 

focused on obtaining an optimal concentration of surface adhesion peptides to allow for 

appropriate RPE development based on ZO-1, actin expression, and other factors such 

as cell circularity, area and actin orientation. All gel concentrations will be compared to 

fibronectin coated glass coverslips as a positive control while PEG only hydrogels will 

function as negative controls. Both ARPE-19 and PRPE cell lines will also be used in 

order to evaluate the differences in immortalized and primary RPE cells when seeded 

on these gels.  

 

C. Hydrogels 

 

1. Hydrogel History 

 

Hydrogels are water-insoluble polymers which absorb a large amount of water. 

These polymers can be derived from both natural and synthetic materials and are used 

in a variety of fields (Society for Biomaterials, 2007). Hydrogels have been used in 

biomedical disciplines for over fifty years in areas such as ophthalmology and surgery 

(Gibas et al., 2010). The first hydrogel developed for potential biomedical use was 

poly-2-hydroxyethyl methacrylate, originally used for soft contact lenses (Gibas et al., 

2010). In the 1980s, calcium alginate was developed for creating microcapsules for 
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cellular engineering (Gibas et al., 2010). Hydrogels today are often used in prevention 

of thrombosis, drug delivery, post-operative adhesion, biosensor coating, cell scaffolds 

and transplantation (Gibas  et al., 2010)(Brandl et al., 2007). 

In order to absorb large quantities of water without dissolving, hydrogels are 

crosslinked using chemical or physical means. This allows the material to maintain 

integrity when placed in a solution. In order to develop these crosslinks, hydrogels are 

commonly bound together using cross-linking agents such as succinimidyl ester amine 

modification or using free radical polymerization. One common technique used to 

create hydrogels in situ is photopolymerization, which uses a light to generate a free 

radical reaction with a crosslinking reagent to combine two polymers. Use of this 

technique allows spatial control, curing speed control and minimal heat production 

(Gibas et al., 2010).  

 

2. Poly(ethylene glycol) Hydrogels 

 

PEG hydrogels are well known for their biocompatibility and optical transparency 

(Brandl et al., 2007). Their ability to form semi-permeable membranes and large 

aqueous content make them a strong candidate for a synthetic Bruch’s membrane. 

Other factors such as mechanical stiffness and functional modification also help 

promote their use in biomedical applications (Brandl et al., 2007). This versatility of 

PEG is made possible by first functionalizing the ends of the PEG hydroxyl chains in 

order to allow them to bind to one another (if the original hydroxyl groups are not 

used). Both ends of the chain can be either purchased or synthesized with the same or 
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different functional groups to allow for further control of how the polymer crosslinks to 

other chains. 

There is only one caveat to the use of PEG hydrogels for the use of a synthetic 

Bruch’s membrane; its inability to promote cellular adhesion (Gombotz, 2004). This 

can be resolved by incorporating functional PEG groups that promote cellular adhesion. 

 

 
FIGURE 4 - Poly(ethylene glycol) (Ozden 2012) 

 

An excellent example of using different functional groups with this polymer are 

ligand modified PEG polymers. The use of modified PEG hydrogels with attachment 

ligands is very well documented (Patel et al., 2005). Ligands such as YIGSR and 

RGD(S), peptide segments of laminin and fibronectin, respectively, are commonly used 

to promote cellular adhesion to materials. These PEG-peptide polymers have been used 

with multiple cell types such as smooth muscle cells and preadipocytes (Mann et al., 

2001) (Patel et al., 2005). Attachment and migration has also been studied using 

fibroblasts on modified PEG hydrogels (Gobin and West, 2002).  Using specific 

attachment ligands also promotes specific cellular adhesion (Mann et al., 2005). 

Specific placement of these attachment molecules also add a spatial component to the 

synthesized gel, allowing for specific cell targets to bind in certain areas while 

preventing adhesion in another. 
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D. Adhesive Ligands 

 

Many cell types are known to use different adhesion ligands in order to interact 

with the space around them. Integrins and laminins are often used as cues to promote 

cellular attachment (Aisenbrey et al., 2006). Integrins are trans-membrane proteins 

that specifically function as adhesion receptors for cells (Takada et al., 2007). These 

receptors bind to ligands in the ECM, a cell surface or in the extracellular solute 

(Takada et al., 2007). Ligands are heterodimeric and are composed of an α-subunit 

and a β-subunit (Aisenbrey et al., 2006).  There are currently eighteen known α-

subunits and eight β-subunits, forming twenty-four unique combinations that have 

characterized so far (Takada et al., 2007). For RPEs, integrins α3β1, α6β1 and α6β4 

have significant interactions regarding cellular attachment (Aisenbrey et al., 2006). 

Commonly, integrins will interact with a variety of extracellular proteins, such as 

fibronectin and laminin (Boateng et al., 2004).  

With respect to RPE cells, it has been found that adding adhesion ligands such as 

laminin, fibronectin and vitronectin to aged Bruch’s membranes promote attachment 

when compared to non-treated membranes (Tezel, Del Priore and Kaplan, 2004). This 

proves that in order to appropriately replace functional RPE cells, a layer of 

attachment ligands is required. Previous studies have also shown that RPE cells will 

adequately adhere to coatings of fibronectin as well as PEG-RGDS hydrogels 

(Scherzer ,2011). Although PEG-RGDS has been proven as an adhesion ligand, it is 

possible that it may alter cellular function and morphology (Boateng et al., 2004). In 

order to unveil whether or not this is the case with RPE cells, this research is focused 
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on observing morphological properties such as cell circularity, ZO-1 expression and 

actin filament length to ascertain if RPE cells remain differentiated.  

 

1. RGDS 

 

RGDS, the amino acid sequence Arg-Gly-Asp-Ser, is a well-known peptide found 

in the tenth domain of fibronectin and is highly involved in cellular attachment 

(DeLong et al., 2005). The modification of PEG hydrogels with this peptide sequence 

has also been studied extensively with human dermal fibroblasts (Gobin and West, 

2002)(Hahn et al., 2006) as well as with RPE cells (Scherzer, 2010). RGDS 

immobilized films have also been shown to be more stable against heat treatment and 

enhance cellular growth better than fibronectin films (Ito et al., 1991). Some sources 

are commonly found referring to the RGD sequence in respect to cellular attachment. 

Studies have found that when using three different versions of RGD- RGDS, RGDV 

and RGDT, the RGDS was found significant in cellular attachment across five different 

cell tpyes (Hirano et al., 1993).  

RGDS has also been shown to stimulate TGF-β1 sectetion in human mesangial 

cells when bound to integrins (Ortega-Velazquez et al., 2003). TGF-β1 has also been 

linked to proliferation of RPE cells via epithelial-mesenchymal transition (Li et al., 

2011). This shows that using RGDS as an attachment ligand will promote RPE 

proliferation into non-confluent sections of a coated gel.  

The research herein will determine whether or not varied concentrations of PEG-

RGDS (0, 5, 10 and 20 µmol/mL) applied during the gel coating process will affect the 
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deposited surface concentration on PEG hydrogels. Each concentration will then be 

analyzed using phase contrast and confocal microscopy for differences in cellular 

attachment and morphology to determine if an optimal concentration of PEG-RGDS 

can be applied to encourage appropriate RPE expression.  
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III. METHODS AND MATERIALS 

 

 

 In this study, poly(ethylene glycol) (PEG) hydrogels were used as the substrate 

material  to mimic the Bruch’s membrane. PEG hydrogels were modified with different 

concentrations (0, 5, 10 and 20 µmol/ml) of RGDS adhesion peptides.  The effectiveness 

of cell adhesion and confluency was measured using both optical microscopy and 

confocal microscopy techniques. To determine morphological differences, ZO-1 and 

actin were stained and imaged via fluorescence and immunofluorescence using confocal 

microscopy.  The step-by-step procedures and protocols used to fabricate these materials, 

culture the cells on the biomimetic materials and image these substrates is presented in 

detail below.  

 

A. Cell Culture  

 

Previous studies have indicated that immortalized cells may behave differently 

than primary lines, especially in RPE cells (Ablonzsky et al., 2011). These differences 

can be observed in a multitude of ways, such as the morphological distribution of ZO-1 

and actin. In order to determine the effects of RPE cell type when using PEG-RGDS 

coated hydrogels, both immortalized ARPE-19 and primary PRPE cells were used for 

this study. 
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1. ARPE-19 

 

 

 

Adult retinal pigmented epithelial cells (ARPE-19, Retinal Epithelium, Human; 

ATCC; Manassas, VA; Item # CRL-2302) are a spontaneously immortalized cell line 

created by Dunn et al. (Dunn et al., 1996). Cells were incubated at 37°C with 5% CO2 

and cultured in T-75 culture flasks (75 cm2 Cell Culture Flask; Tissue Culture Treated 

with Vent Cap; Corning Inc.; Item # 430641) using Dulbecco’s Modified Eagle 

Medium: Nutrient Mixture F-12 (DMEM/F-12; Corning Inc; Item # 10-092-CV) 

containing 10% fetal bovine serum (FBS; Gibco; Invitrogen; Item # 26140-079) and 

1% Penicillin, Streptomycin and L-Glutamine (PSG; 10,000 IU/mL penicillin, 

10,000μg/mL streptomycin, 29.2mg/mL glutamine; Cellgro; Mediatech; Item # 30-009-

CI) and fed 12mL three times a week. This media along with bovine serum was chosen 

in order to encourage proliferation of cells, which has been successfully used by other 

labs in culturing this cell type (Aisenbrey et al., 2006).  

Once plated, cells were allowed to grow a minimum of two weeks post-

confluency in order to obtain adequate cell densities with a majority of epithelioid 

phenotype. To passage, Trypsin-EDTA (Trypsin-ethylene diamine tetra acetic acid; 

Cellgro; Mediatech, Inc.; Item No. 25-052-Cl) was heated in a water bath at 37°C then 

2mL were added per T-75 culture flask after first aspirating the used media and rinsing 

once with PBS. The flask was then allowed to incubate for 10 minutes. After the cells 

detached from the flask, 5 mL of media was added to deactivate any residual trypsin 

and the cell suspension was moved into a 15mL centrifuge tube. The centrifuge tube 

was then centrifuged for ten minutes at 1000 rpm (Beckman Coulter Allegra 6R 
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Centrifuge). Residual media was aspirated from the cell pellet and the cells are re-

suspended in media. Cells were typically passaged at 1:6 and passages 11-12 were used 

for these studies, although passage numbers for immortalized cell lines are insignificant 

since they do not change characteristically between passages.  

 

2. PRPE 

 

 

 

Porcine retinal pigmented epithelial cells (PRPE) were obtained from primary 

cultures from Qun Zeng, a postdoctoral researcher from the Tezel Lab in the 

Department of Ophthalmology and Visual Sciences. This cell type was cultured under 

similar conditions as ARPE-19 cells. However, the primary cultures were only 

passaged once to ensure adequate ZO-1 expression and decrease risk of 

dedifferentiation prior to seeding on gels.  Cells were allowed to grow a minimum of 

one-week post-confluency to ensure proper epithelioid phenotype.  

 

B. PEG-DA Synthesis 

 

 

 

Poly(ethylene glycol) (PEG) (MW 6000; EMD; Item # PX1286L-4) was weighed 

out in a glass beaker and then lyophilized overnight to remove any water from the 

sample. All necessary glassware was dried overnight at 100°C. Synthesis begins by 

adding PEG to a round bottom flask thrice evacuated and filled with argon. The flask 

was then evacuated and filled again with argon. Up to 40 mL of anhydrous 

dichloromethane (DCM; Sigma; Item # 270997) was added 10 mL at a time via glass 
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syringe. Enough anhydrous DCM was used to make a non-viscous solution. The 

evacuation process was once again repeated with argon. Triethyl amine (TEA; Sigma; 

Item # 90335) was then added to the solution at a 2:1 molar ratio and allowed to mix 

for five minutes. TEA acts as a catalyst by binding to free hydroxyl groups. After 

repeating the evacuation process, acryloyl chloride (Sigma, Item # A24109) was added 

slowly to the flask at a 2:1 molar ratio. Acryloyl chloride reacts with bound TEA on 

PEG to create acrylate end groups. The solution was then evacuated with argon and 

allowed to react overnight.  

After allowing the mixture to react for at least 12 hours, the phase separation 

process begins. The PEG mixture was moved into a 500mL separatory funnel. 2M 

potassium carbonate (K2CO3; Acros; Item #42408) was added to the mixture to wash 

the solution. The funnel was then sealed and shaken, venting after every fifteen to 

twenty seconds. This process was repeated until no more CO2 was released. Parafilm 

was then placed on the separatory funnel in place of the stopper and allowed to separate 

for 24-36 hours. This separation allows for the separation of KCl into the aqueous 

phase and the PEG-DA into the organic phase.   

Next was the purification process. After allowing the organic and aqueous phase 

to separate, the denser organic phase was drained into a separate beaker. Magnesium 

sulfate (MgSO4; Fisher; Item #M65-500) was added as a drying agent while stirring the 

organic phase. The mixture was then filtered using a vacuum flask and a Buchner 

funnel with the filter paper pre-wet with DCM to remove the MgSO4. Diethyl ether 

((C2H5)2O; Sigma; Item #673811) was then added to the remaining PEG solution in a 2 

L beaker to precipitate the PEG-DA out of solution. The precipitate was then filtered 
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using a Buchner funnel and paper pre-wet with ether. The PEG-DA powder was then 

dried overnight under vacuum, dialyzed overnight in a 3500 Dalton molecular weight 

membrane (Spectra/Por 7 Dialysis Membrane; molecular weight cutoff 3500; Spectrum 

Laboratories; Item # 132111) in deionized water and sequentially lyophilized 

overnight. The resultant PEG-DA powder was stored under argon at -20°C.  

 

C. PEG-RGDS Synthesis 

 

PEG-RGDS was synthesized using a combination of monoacrylated PEG 

succinimidyl valerate at 3400 dalton molecular weight (Acrylate-PEG-SVA; Laysan 

Bio; Item # ACRL-PEG-SVA-3400-1g.) and RGDS peptide (H-Arg-Gly-Asp-Ser-OH; 

Calbiochem; Item # 03-34-0002-25MG.) at a 1:1 molar ratio. These are first dissolved 

separately in 50mM sodium bicarbonate (NaHCO3; Mallinckrodt Chemicals; Item # 

7412-12) in deionized water at a minimum pH of 8.5. The dissolved RGDS was then 

added dropwise to the Acrylate-PEG-SVA solution and was allowed to mix on an 

orbital shaker in a centrifuge tube wrapped in foil for a minimum of four hours. The salt 

and SVA ester was removed from the solution by dialysis using a 3500 Dalton 

molecular weight cutoff membrane  (Spectra/Por 7 Dialysis Membrane; molecular 

weight cutoff 3500; Spectrum Laboratories; Item # 132111). The residual PEG-RGDS 

solution was then lyophilized overnight. The resultant PEG-RGDS powder was stored 

under argon at -20°C.  
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D. PEG-RGDS-Fluor 488 Synthesis 

 

PEG-RGDS-Fluor 488 was synthesized in a method similar to PEG-RGDS. PEG-

RGDS was either allowed to conjugate in the sodium bicarbonate solution as explained 

above, or was added back into sodium bicarbonate solution of the same strength (50 

mM, pH 8.5 minimum). AlexaFluor 488 carboxylic acid, succinimidyl ester 

(AlexaFluor 488 carboxylic acid, succinimidyl ester; Invitrogen; Item # A20000) was 

then added dropwise to the PEG-RGDS solution at a molar concentration of 10:1 

(AlexaFluor 488:PEG-RGDS). The mixture was allowed to react for a minimum of four 

hours on an orbital shaker while wrapped in foil. The salt and residual AlexaFluor 488 

dye was removed from the solution by dialysis using a 3500 Dalton molecular weight 

cutoff membrane (Spectra/Por 7 Dialysis Membrane; molecular weight cutoff 3500; 

Spectrum Laboratories; Item # 132111). The residual PEG-RGDS-Fluor 488 solution 

was then lyophilized overnight. The resultant PEG-RGDS-Fluor 488 powder was stored 

under argon at -20°C wrapped in foil.  

 

E. PEG-DA Hydrogel Formation 

 

Molds for gels are preassembled using glass coverslides (25mm x 75mm x 1mm; 

VWR; Item # 48300-025), 0.5 mm electrophoresis spacers (Fisher; Item # FBVE1033) 

and binder clips (Staples, Item # 831610). Silicone vacuum grease (Dow Corning; 

Sigma; Item # Z273554-1EA) was used to seal the mold and the molds are sterilized 

overnight using a UV light. PEG-DA hydrogels are polymerized using 10% w/v PEG-
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DA in (10mM) HEPES. Twenty microliters of acetophenone photoinitiator (2, 2-

dimethoxy-phenyl-acetophenone; Sigma; 196118-50G) at 200mg/mL in N-

vinylpyrrolidone (NVP; Acros Organics; CAS # 88-12-0) was added per milliliter of 

PED-DA solution. The solution was then filter-sterilized using a 0.22µm PES syringe 

filter (Millex-GP; Millipore Corporation; Item # SLGP033RS) in the biological laminar 

flow hood. Approximately 1.5 mL of PEG-DA solution was then injected into each 

mold and was polymerized for 1 minute using a 5mW 365nm UV light (Blak-Ray 

B100-A; Fisher). The molds are then opened to expose the gel sheets and circular gels 

are punched using a #5 (10mm) hole punch. Four gels were prepared for each peptide 

concentration group (0, 5, 10 and 20 µmol/mL) described below in the next section.  

Gels are then allowed to swell in PBS for a minimum of one hour at room temperature.  

 

F. Hydrogel Coating Procedure 

 

PEG-DA hydrogels are surface modified with PEG-RGDS using either 5, 10 or 

20 µmol/mL solution concentrations of PEG-RGDS. These solutions are made by 

weighing out the desired amount of PEG-RGDS for a 20 µmol/mL solution and adding 

the powder to 10mM HEPES. Enough solution was made to serial dilute and create the 

other required concentrations. Photoinitiator was then added at a ratio of 20 µL per mL 

of PEG-RGDS solution. The solution was then filter-sterilized using a 0.22µm PES 

syringe filter (Millex-GP; Millipore Corporation; Item # SLGP033RS) in the biological 

laminar flow hood. Non-coated gels are prepared by placing the gels to be coated onto 

coverslides and removing any residual PBS. Ten microliters of the desired 
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concentration of PEG-RGDS is then added to the top of each gel and is covered using a 

24 x 60 mm coverslip (VWR; Item # 48393-106). This was determined based on the 

amount of solution required to completely coat the surface of the gel. The gels are then 

polymerized for 3 minutes using a 5mW 365nm UV light (Blak-Ray B100-A; Fisher). 

Each gel was then placed into a 24-well culture plate (Corning Costar; Sigma; Item # 

CLS3524-100EA) and rinsed with 500 µL of PBS.  

 

G. Quantification of Peptide Coating Using Rinse Supernatant 

 

After PEG-DA hydrogels are surface modified with PEG-RGDS-Fluor 488 using 

the same technique as described in section F above. In this instance, gels are coated 

with a 10:1 ratio of PEG-RGDS to PEG-RGDS-Fluor 488 using the same total 

concentrations (20, 10 and 5 µmol/mL).  These gels are polymerized individually in 12-

well plates and covered with a 12mm coverslip to ensure a flat coating (Fisher; Item # 

12-545-80). After polymerization and the initial PBS rinse of 500µL, each gel was 

rinsed twice at 4 and 24 hours after polymerization to remove any non-grafted peptide 

conjugate. All three rinses are collected cumulatively from each individual gel. 

PEG-RGDS-Fluor488 coating fluorescence standards are also made by adding 

5µL of each coating concentration in wells of a 24-well plate, covering with a 12mm 

coverslip and exposing to UV along with the coated gels. 750µL of PBS was then 

added to each standard to equal 100% coating solution concentrations for fluorimetric 

standards.Individual sample wells and coating standards were measured using a 

fluorimeter (Turner Biosystems Modulus 9200). These values were then compared to 
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previously obtained fluorescent standards for concentrations to determine coating 

concentration values. Average percent grafted, concentration grafted and µg/cm2 was 

calculated for each group. Average percent grafted was calculated by subtracting the 

average rinse concentration from the average coating concentration. Total concentration 

grafted was then calculated using the measured coating concentration multiplied by the 

percent grafted to the gel. The concentration grafted was then translated into 

micrograms grafted to the gel surface using the coating volume and the molecular 

weight of the peptide. This was then multiplied by the surface area of the gel to 

determine the average µg/cm2 per group. These values were recorded in Microsoft 

Excel 2012 and statistically analyzed by a paired t-test using Minitab 16 statistical 

software and α = 0.05. 

 

H. Quantification of Peptide Coating using Confocal Microscopy 

 

Fluorescently coated gels are imaged using Nikon Eclipse Ti (Nikon Instruments 

Inc.; Melville, NY) running the Nikon Elements Image Software (NIS-Elements, AR 

3.1.Ink; Laboratory Imaging, Nikon Instruments Inc.; Melville, NY). Images were 

taken using a 60x oil immersion objective. The basic confocal setting are as follows: 

image capturing speed of 1/8 frames/sec, an image size of 2048x2048 pixels, and a 

pinhole size 24.3µm. The initial GFP-UV (for AlexaFluor 488) settings were HV=120, 

offset= 0 and laser power = 5% and the Z-steps were set at 1µm with a total area of 20 

µm, creating 21 images.  Z-stacks were then exported into separate TIF files for each Z-

stack acquired. Individual images were then combined using ImageJ (Version 1.47) into 
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stacks and converted into maximum intensity images to display the total maximum 

intensity per sample. All images were then set to a unified scale of 200-2000. The 

average intensity of each image was then recorded using the ‘Analyze -> Measure’ 

feature. These values were recorded in Microsoft Excel 2012 and statistically analyzed 

by a paired t-test using Minitab 16 statistical software and α = 0.05. 

 

I. Preparation of RPEs on Hydrogels 

 

Surface modified PEG-DA hydrogels are seeded with cells at the appropriate 

cellular density to achieve confluency for each of the respective cell types and gel 

groups (ARPE-19 were approximately 90,000 cells/cm2, PRPE were approximately 

110,000 cells/cm2) and were dry seeded by adding cell suspension onto the top of gels 

in 12-well plates. After allowing 4 hours for cellular adhesion to the surface of the gel, 

the wells were flooded with media to the required volume (500mL). A minimum of 

four gels were prepared for each group (0, 5, 10 and 20 µmol/mL) as well as for each 

cell type. Gels were then held stationary using size M7 A2 stainless steel washers 

(Grainger, Item # 6EY95) and 500 µL of DMEM/F-12 media was added to each gel. 

The cells on the gels were fed three times a week. After seven days, the cell-coated gels 

were rinsed briefly with PBS and fixed with 4% formaldehyde (16% Formaldehyde 

diluted in PBS; Thermo Scientific; Item #28908) for 10 minutes.  
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J. Preparation of RPEs on Fibronectin 

 

Fibronectin coated coverslips were also used in each study as a positive control. 

The control samples were constructed by coating 12mm glass coverslips with 

fibronectin (Sigma; Item # F1141) at 1.825 µg/cm2 (100 µl of 21.25 µg/mL per 

coverslip). The coated coverslips were then left at 4°C overnight in the refrigerator and 

the residual liquid coating was removed before seeding. Cells were then dry seeded at 

the appropriate cellular density to achieve confluency for 4 hours and then fed 

DMEM/F-12 three times a week. After seven days, the clips were rinsed briefly with 

PBS and fixed with 4% formaldehyde (16% Formaldehyde diluted in PBS; Thermo 

Scientific; Item #28908) for 10 minutes.  

 

K. Phase Contrast Microscopy 

 

Fixed gels and coverslip controls were imaged to determine cell confluency using 

a phase contrast microscope (Nikon Eclipse TE2000-4) equipped with a Retiga 2000R 

Fast Cooled Mono 12 Bit camera (Q Imaging) and interfaced with Metamorph software 

(v7.0r2; Universal Imaging Corporation). These images were taken using a 10x air 

objective. Light intensity and exposure were adjusted until cell boundaries were easily 

visible. Images were then saved as TIF files and cropped to 1200x1200 to remove 

objective artifacts shown in the corners of original saved images. Images were also 

optimized with the ImageJ software using the ‘Process -> Enhance Contrast’ setting 

with saturated pixels set at 0.4% to allow for a more defined boundary layer on each 
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image. Next, using the ‘Freehand Selections’ tool, cell edges exposing the underlying 

gel were traced and filled in with a solid black color using ‘Edit -> Fill’. After covering 

all exposed areas of the gel, a threshold image was generated using ‘Image -> Adjust -> 

Threshold’ to convert the image into a binary state. Cells were white while the exposed 

gel area was black. The number of white pixels for each image was then obtained using 

‘Analyze -> Histogram’ and selecting the ‘List’ button to present numerical values. 

This list was then saved and opened in Excel. Using the ratio of white pixels to the total 

number of pixels per image, a percentage of total confluency was obtained. The 

obtained percentages for each image were then statistically analyzed using a paired t-

test using Minitab 16 statistical software and α = 0.05. 

 

L. Immunostaining Procedure 

 

After 7 days, samples were placed in 12-well plates, permeabilized and blocked 

with 0.5% Triton-X (Triton X-100; Item # 082513) in PBS with 1% bovine serum 

albumin (BSA, Sigma, Item # A7906-10G) and 0.2% sodium azide (NaN3, Acros 

Organics, Item # 190380050) (PBS-BSA-Azide) for 10 minutes, respectively. The 

samples were then placed on an orbital rocker throughout the duration of staining.  The 

samples were then rinsed twice with 300µL of PBS-BSA-Azide for 5 minutes each.  

For each gel sample, 250 µL of staining solution was used, except for the fibronectin 

control slips where 200 µL of staining solution was used. Following rinsing, the ZO-

1primary antibody (Rabbit polyclonal Anti-ZO-1; Abcam; ab58720) was added at 1:50 
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dilution. The sample was then placed on the rocker at 4°C in the cold room overnight to 

allow the primary antibody ample time to bind.  

The following day, samples are removed from the rocker, allowed to acclimate to 

room temperature and rinsed 6 times with 300 µL of PBS-BSA-Azide for 5 minutes 

each. Next, the AlexaFluor 488 labeled secondary antibody (Goat anti-rabbit; 

Invitrogen; Item # A11034) was added to each sample at 1:100 dilution in PBS-BSA-

Azide and rocked for 1 hour at room temperature. Following another 5 rinses with 300 

µL of PBS-BSA-Azide for 5 minutes each, rhodamine-phalloidin (R-P; Invitrogen; 

R415) in PBS-BSA-Azide at 1:40 dilution was added to the samples and rocked for 40 

mins at room temperature. The both gel groups and controls were then rinsed twice 

with 300 µL of PBS-BSA-Azide for 5 minutes each. Lastly, the samples are stained 

with 4',6-diamidino-2-phenylindole (DAPI; Invitrogen; D1306) at 600nM concentration 

in PBS-BSA-Azide for 5 minutes. The samples were then rinsed twice with PBS-BSA-

Azide and ready for confocal microscopy analysis. 

  

M. Confocal Microscopy 

 

The immunostained gels and controls were imaged using the same confocal 

imaging configuration as mentioned above in section H except the basic confocal 

settings were as follows: image capturing speed of 1/24 frames/sec, an image size of 

2048x2048 pixels, and a pinhole size from 14.3-32.1. Three imaging channels were 

obtained; DAPI, GFP-UV, and TxRed. The initial DAPI settings were HV=84-129, 

Offset= 0 and Power = 2-20.1%, while the initial GFP-UV (for AlexaFluor 488) 
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settings were HV=75-101, Offset= 0 and Power = 0.5-5.4% and the initial TxRed (for 

R-P) settings were HV=70-100, Offset= 0 and Power = 0.1-2.1. Besides image size and 

frame speed, each of these parameters were adjusted manually in order to optimize each 

recorded image. Z-steps were recorded for each image in order to provide a fully 

encompassing image of ZO-1 and actin formations at different heights within the cell. 

An average of 20 Z-stack images per final image were acquired for each gel to 

encompass the entire thickness of each gel’s cell layer. Z-stacks were then exported 

into separate TIF files for all three channels and into separate Z-stacks. Individual 

channels were then combined using ImageJ into stacks and converted into maximum 

intensity images as well as composite images with all color channels. Due to the 

significant amount of time required to image individual gels as well as the requirement 

to prepare each gel shortly before imaging to prevent drying, a sample size of n=2 was 

used for each set to reduce the effect of photobleaching during preparation and decrease 

the effect of time lapse between samples.  

 

N. ZO-1 Analysis 

 

Staining for ZO-1 was analyzed using ImageJ software. Maximum intensity 

images obtained using confocal microscopy were analyzed by first adjusting the image 

brightness and contrast using ‘Image -> Adjust -> Brightness/Contrast’ to allow for 

easy visualization of ZO-1 boundaries. Cell ZO-1 boundaries were then manually 

traced using the ‘Polygon Selections’ tool. Once a cell was traced completely, a line 

was drawn onto the image using ‘Edit -> Draw’. This was repeated until no other cells 
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could be accurately traced or a sufficient number of samples were obtained to represent 

the gel. Samples between n=1 and 21 were obtained for the images collected for this 

experiment, depending on the quality of the image and cell size. Once completed, the 

file was saved separate from the original ZO-1 image for later use. After the cells were 

traced, a binary image was generated using ‘Image -> Adjust -> Threshold’ to convert 

the image into a binary state and only display the tracings. This image was then saved 

as a separate file and numbered to correlate to measured values. The non-numbered 

tracings were then individually selected in numerical order using the ‘Wand’ tool. The 

tracings were then measured for area, perimeter, circularity and aspect ratio using 

‘Analyze -> Measure’. This was repeated sequentially for each tracing in order and the 

measurements were saved to an Excel file. After each image was analyzed, all 

measurements were compiled into one single Excel document and average values of 

area, perimeter, circularity and aspect ratio were obtained for each group. The compiled 

data was also pasted into Minitab 16 and statistically analyzed by a multifactor 

ANOVA and a non-paired t-test assuming equal variance using Minitab 16 statistical 

software and α = 0.05. 

 

O. Actin Analysis 

 

Staining for Actin was analyzed using ImageJ software. Maximum intensity 

images obtained using confocal microscopy were analyzed by first adjusting the image 

brightness and contrast using ‘Image -> Adjust -> Brightness/Contrast’ to allow for 

easy visualization of Actin filaments. Actin filaments were then manually traced using 
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the ‘Line’ tool. Once traced, a line was drawn onto the image using ‘Edit -> Draw’. 

This was repeated until a sufficient number of samples were obtained to represent the 

gel. Once completed, the file was saved separate from the original Actin image for later 

use. After the cells were traced, a binary image was generated using ‘Image -> Adjust -

> Threshold’ to convert the image into a binary state and only display the tracings. This 

image was then saved as a separate file and numbered to correlate to measured values. 

The non-numbered tracings were then individually selected in numerical order using 

the ‘Wand’ tool. The tracings were then measured for length and angle using ‘Analyze -

> Measure’. This was repeated sequentially for each tracing in order and the 

measurements were saved to an Excel file. After each image was analyzed, all 

measurements were compiled into one single Excel document and average values of 

length and orientation were obtained for each group. The compiled data was also pasted 

into Minitab 16 and statistically analyzed by a multifactor ANOVA and a non-paired t-

test assuming equal variance using Minitab 16 statistical software and α = 0.05. 
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IV. RESULTS AND DISCUSSION 

 

 

 

Four specific aims were addressed in this research. First, the concentration of 

PEG-RGDS deposited onto each gel group was evaluated and quantified using a 

fluorescently tagged PEG-RGDS substitute. The second specific aim was to evaluate 

the ability of PEG-DA hydrogels surface coated with PEG-RGDS to functionally 

support attachment of RPE cells. The last two specific aims focused on the observation 

of the morphology of both ZO-1 and actin expression by both ARPE-19 and primary 

porcine RPE cells. Staining for these specific cellular structures allowed for 

quantification of cell circularity, cell area, aspect ratio, actin length and orientation. 

Four gel concentration groups (0, 5, 10 and 20 µmol/mL) were used for each study as 

well as fibronectin coated 12mm coverslips for a positive control.  

 

A. Quantification of PEG-RGDS Coating (Fluorescence) 

 

Quantification of the PEG-RGDS coating applied to each group of gels was 

analyzed using two different techniques. The first was using retained rinses from 

individual gels and obtaining a fluorescent intensity measurement for the amount of 

PEG-RGDS-Fluor 488 not polymerized to the surface of the gel. These values were 

then compared to a standard generated by using the same volume of each 

concentration as the gel coating, exposing it to the same UV time and diluting using 

the same amount of rinses. Using the standard curve generated, the average 
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concentration per group, percent PEG-RGDS-Fluor 488 grafted and an average 

concentration per centimeter squared was obtained.  The results of this experiment are 

shown in Figures 5 as well as in Tables I-III. Calculations were obtained using the 

procedures described in the methods and materials section above. 

 

 
FIGURE 5- Standard Curve of PEG-RGDS-Fluor 488 Fluorescence 

 

Conc. 
µmol /ml Avg. FSU 

Avg. 
µmol/mL 

0 118 0.026 

5 35,490 5.261 

10 84,831 9.863 

20 254,116 20.009 
TABLE I -Standard Curve Analysis 
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Conc. 
µmol/ml Avg FSU 

Avg µmol/mL in 
rinse %Grafted +/-SD µg/cm2 +/-SD 

0.026 169 0.036 -42.94 46.76 0* 0* 

5.26 33,755 4.98 5.29 6.98 9.09 12.00 

9.86 81,089 9.37 5.04 3.90 17.33 13.42 

20.01 246,532 19.13 4.40 6.88 30.25 47.31 
TABLE II - Quantification of PEG-RGDS Coating Fluorescence 

*Since percent attachment is less than zero, no PEG-RGDS-Fluor 488 is present. 

 

T-Test p-values µg/cm2 

Group Vs p-value 

0 5 0.113 

0 10 0.041 

0 20 0.145 

5 10 0.143 

5 20 0.233 

10 20 0.274 
TABLE III -Average µg/cm2 p-values. Yellow indicates significance. 

 

In generating a standard curve, it was noted that the best trend-line fit was a 

second order polynomial. Using this generated curve, each individual measurement was 

first translated into the values shown in Table I. Table II shows the same values 

calculated as percent grafted and micrograms per centimeter squared. Since the 

standard curve technique recorded a negative percent attachment for the negative 

control gels, the concentration was assumed to be zero and no concentration was 

calculated for this group. Total percent attachment for each group was shown to be 

between 4 and 5 percent, which is less than the measured yield by Hahn et al. using a 

Ninhydrin assay (Hahn et al., 2006) for fluorescently tagged PEG-RGDS for PEG 

hydrogels and near identical preparation processes. The increased surface concentration 

grafted may also be due to the use of a smaller molecular weight PEG for the hydrogel 

itself (3400 vs 6000), increasing free acrylates on the surface and increasing RGDS 



 

48 

 

grafting.  For the mass per unit area of RGDS coverage results, only the 0 and 10 

µmol/mL groups were observed to be significantly different from one another using a 

paired t-test, most likely due to the inaccuracies in the analysis technique performed. As 

a result, the gel study was further analyzed using confocal microscopy images.  

 

B. Quantification of PEG-RGDS Coating (Confocal) 

 

After polymerizing gels using the same protocol as the previous quantification 

method, each gel was imaged using confocal microscopy to observe the homogeneity of 

the coating as well as obtain a greyscale intensity value for comparison of each group. 

This was obtained by the creation of a maximum intensity image composed of 21 Z-

stacks each one-micron apart. The stack begun immediately before fluorescence was 

detected and completed when the fluorescent intensity visibly diminished. 

Representative images of each group are shown in Figure 6. The average values 

obtained from each group are displayed graphically in Figure 7, while the p-values 

obtained from a paired t-test is listed in Table IV.  
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FIGURE 6- PEG-RGDS-Fluor 488 Hydrogels. Sample images of A) 0 B) 5 C) 10 and D) 20 µmol/mL groups. 

Scale bar represents 50µm. 
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FIGURE 7- Concentration vs. Average Greyscale Intensity 

 

 

t-test Intensity 

Group Vs p-value 

0 5 0.007 

0 10 0.011 

0 20 0.007 

5 10 0.043 

5 20 0.048 

10 20 0.436 
TABLE IV -Average Greyscale Intensity p-values. Yellow indicates significance. 

 

The images captured in this study showed highly homogeneous distributions of 

the RGDS peptide on the PEG hydrogel via fluorescence, clearly demonstrating that the 

PEG-RGDS-Fluor 488 coating is evenly distributed across the surface.  All raw images 

acquired are shown in Appendix I. The image intensity also decreased as Z-stacks 

progressed further into each gel, revealing that the majority of the attached PEG-

RGDS-Fluor 488 is on the surface of the gel.  

Overall, the average intensity measured for each gel group showed significantly 

less coefficient of variance than what was shown using the previous technique. This 
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method also allowed for statistically significant differences to be shown between each 

group except for 10 and 20µmol/mL. The intensity values seemed to plateau near 

20µmol/mL, indicating that a maximum concentration may be deposited on the surface 

within the polymerization time tested. Interestingly, the R2 value for a linear trend-line 

intersecting at the intensity recorded at the 0µmol/mL group is 0.9259, even though the 

logarithmic trend shown in the figure displays a higher R2 (0.9772).  Larger sample 

sizes analyzed for each group may reduce the coefficient of variation further; thereby, 

decreasing the coefficient of variation values, improving the linear R2 value and the 

level of significance for all groups. In general, this technique proved to be a better tool 

for determining quantification of RGDS attached to the surface, since lower variances 

were observed between each group as well as providing a visual confirmation that the 

RGDS was homogeneously grafted on the surface of the gel.  

 

C. Quantification of Cellular Confluency on Hydrogels 

 

Cell adhesion was also measured for each sample group in order to determine 

whether or not these concentrations allowed significantly different percentages of 

attached cells compared to fibronectin coated coverslips. Sample images of cell 

adhesion for both ARPE and PRPE cells are shown in Figures 8 and 10 and the 

complete set of raw images for all cell adhesion samples can be found in Appendix II. 

The results of the analyses performed on all images are shown in Figures 9 and 11 for 

ARPE-19 and PRPE cell lines, respectively. P-values for paired t-tests on each cell type 

are displayed in Tables V and VI. 
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FIGURE 8- ARPE-19 10µmol/mL sample. Scale bar represents 250µm. Black areas indicate bare areas without 

cell coverage. 

 

 
FIGURE 9- ARPE-19 Attachment to Surface. Values represent percent cell attachment. 
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t-test ARPE confluency 

Group vs p-value 

0 5 <0.0001 

0 10 <0.0001 

0 20 <0.0001 

0 FN <0.0001 

5 10 0.469 

5 20 0.437 

5 FN 0.071 

10 20 0.367 

10 FN 0.038 

20 FN 0.093 
TABLE V -ARPE-19 Confluency p-values. Yellow indicates significance. 

 

For the ARPE-19 cells, ≥ 97% confluency was observed for every gel group, 

except for the negative controls. A representative image for 10 umol/ml concentration 

of RGDS is shown in Figure 11 (all other ARPE-19 confluency images are shown in 

Appendix II). All RGDS concentration hydrogel groups were found to be significantly 

different than the non-coated gels (0 umol/ml concentration) as expected. Additionally, 

the 10µmol/mL group was found to be significantly different than the fibronectin 

controls. This may be due to the lack of variance recorded for fibronectin controls since 

no images were found to have bare areas without cellular growth.  

For PRPE cells, ≥ 97% confluency was observed for every gel group, except for 

the negative controls. A representative image for the 10 umol/ml concentration of 

RGDS is shown in Figure 13 (all other PRPE confluency images are shown in 

Appendix II).  Only the non-coated gels were statistically significant from all other gels 

as was expected.  
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FIGURE 10- PRPE 10µmol/mL sample. Scale bar represents 250µm. Black areas indicate bare areas without 

cell coverage. 
 

 
FIGURE 11- PRPE Attachment to Surface. Values represent percent cell attachment. 
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t-test P confluency 

Group vs p-value 

0 5 <0.0001 

0 10 <0.0001 

0 20 <0.0001 

0 FN <0.0001 

5 10 0.125 

5 20 0.078 

5 FN 0.102 

10 20 0.087 

10 FN 0.075 

20 FN 0.173 
TABLE VI -PRPE Confluency p-values. Yellow indicates significance. 

 

 

 

As for both cell types, nearly all groups measured showed no significant 

differences when compared to fibronectin controls. This shows that all concentrations 

are capable of promoting a confluent layer of cells for both cell types. These results 

also match well with observed PEG-RGDS surface densities (0-100 µg/cm2) for human 

dermal fibroblasts (Moon 2009). Perfecting the gel fabrication procedures to attain 

smoother gel surfaces may increase the observed cell confluency since a small portion 

of confluency defects appeared to be due to imperfections in the gel surface. The 

imperfections may have been a result of bubble formation during the coating procedure 

since RPE cells tend to prefer a flat surface in order to fully propagate (Scherzer 2010). 

As for achieving an optimal concentration of PEG-RGDS for RPE cell adhesion and 

allowing cells to migrate onto the surface, one would need to select a concentration 

requiring the lowest amount of PEG-RGDS while still supporting appropriate cell 

morphology and differentiation in order to decrease overall production costs.  
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D. Determination of RPE Differentiation: ZO-1 Cell Circularity 

 

RPE cellular morphology was also observed using immunocytochemistry 

techniques. All groups were coated with cells at confluent densities and fixed after 7 

days. A sample size of two per group was used for staining each time the experiment 

was executed due to the large amount of time required to image each sample. All 

sample images were then analyzed using ImageJ and Minitab 16. A representative 

image for 10 umol/ml concentration of RGDS is shown in Figure 12 (all other ZO-1 

images are shown in Appendix III). Analyzed gels are also located in Appendix III and 

are labeled as ‘ZO-1 analysis’. The total number of cells measured as well as number of 

gels analyzed are listed in Table VII. Only one image in the 0µmol/mL gels was found 

to have an attached cell layer; however, based on the fact that this layer of cells was not 

adhered to the substrate, was folded over on itself and did not demonstrate confluency, 

this image was not included in the analysis.  

 

 

 
FIGURE 12- PRPE 10-2-1 (5/17/13) 
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Sample Gel # Counted 

ARPE-5 1 8 

ARPE-10 1 5 

  2 12 

ARPE-20 1 5 

  2 16 

ARPE-FN 1 3 

  2 1 

  3 3 

PRPE-5 1 13 

  2 7 

  3 11 

PRPE-10 1 13 

  2 11 

  3 9 

  4 11 

PRPE-20 1 11 

  3 5 

  4 9 

PRPE-FN 1 11 

  2 13 

  3 15 

  4 21 
TABLE VII -Gel and Cell Number Count 

 

Cellular circularity is determined using Equation 1. This equation provides a 

value between zero and one, with one being a perfect circle. As a cell becomes more 

densely packed and more epithelioid in shape, the circularity value of the cellular 

boundary approaches one. Therefore, the higher the circularity value the more 

epithelioid and differentiated the cell.  

 

𝑓𝑐𝑖𝑟𝑐 =
4𝜋 ∙ 𝐴𝑟𝑒𝑎

𝑃𝑒𝑟𝑖𝑚𝑒𝑡𝑒𝑟2
       𝐸𝑞𝑢𝑎𝑡𝑖𝑜𝑛 1 
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Due to the inability to discern proper ZO-1 expression in some images, only a few 

cells were analyzed from each gel, especially in the ARPE-19 images. A minimum of 

four gels were analyzed for all samples, but only images containing ZO-1 expression 

for analysis are included within the numerical values and figures. Figure 13 also shows 

an example of the differences between images, where the left image illustrates cells in a 

more epithelioid shape, which corresponds to higher circularity values. The image on 

the right demonstrates cells that display more fibroblastic phenotypic behavior, with 

smaller circularity values and significantly less ZO-1 expression around the perimeter 

of the cells. 

  

  
FIGURE 13- Left – PRPE cells on fibronectin, image FN-2-2; and, Right - ARPE cells on fibronectin, image FN-

1-4.  The bright oval/circular spots indicate nuclei and the bright lines surrounding the nuclei identify ZO-1 

located on the periphery of the cells. 
 

The following data on cell circularity was obtained from the analysis of the ZO-1 

images obtained from each group (Figure 14). Only one RGDS concentration pair was 

found to be statistically significant for ARPE-19 cells (10 and 20µmol/mL), although 

the RGDS concentration pair of 10µmol/mL and FN show a p-value of 0.08. For the 
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PRPEs, all RGDS concentration pairs were found to be statistically significant from the 

fibronectin controls. This shows that fibronectin promotes a more epithelioid shape 

than all three RGDS gel concentrations. In comparing differences between cell types at 

the same RGDS gel concentrations, t-test analysis showed a significant difference for 

all cases, except for the 10µmol/mL, with PRPE cells displaying a higher circularity 

(Table VIII). This is potentially due to a smaller sample size within ARPE-19 samples 

(17), increasing the potential variability of the sample and decreasing its significance 

compared to the number of PRPE samples (44).  

 

 
FIGURE 14- Circularity by Group. Bars indicate standard deviation.  

 
 

t-test A Circularity 
 

t-test P Circularity 
 

t-test 
 

Circularity 

Group vs p-value 
 

Group vs p-value 
 

Group vs p-value 

5 10 0.176 
 

5 10 0.132 
 

A-5 P-5 0.022 

5 20 0.187 
 

5 20 0.311 
 

A-10 P-10 0.237 

5 FN 0.270 
 

5 FN 0.000 
 

A-20 P-20 0.000 

10 20 0.011 
 

10 20 0.288 
 

A-FN P-FN 0.038 

10 FN 0.080 
 

10 FN 0.000 
    20 FN 0.495 

 
20 FN 0.000 

    TABLE VIII -Circularity p-values Left- ARPE-19 groups. Center- PRPE groups. Right- ARPE vs. PRPE 

groups. Yellow indicates significance. 
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A multi-factor ANOVA following the General Linear Model was also performed 

using Minitab 16 to observe significance between concentrations, gels and cell types. 

Three ANOVAs were performed; one ANOVA for each cell type as well as an 

ANOVA for all samples. These results are listed in Table IX. Individual PRPE gels are 

shown to be a significant factor in the ANOVA as well as between the different RGDS 

gels concentrations. Cell type, concentration and RGDS gel concentration are also 

shown to be significantly different when comparing the ANOVA data between cell 

types. A Tukey’s Test analysis to determine circularity differences between gels of 

different RGDS concentrations is shown in Table X, with the PRPE data showing a 

statistically significant difference between fibronectin and the rest of the RGDS 

concentrations, matching the p-values in Table VIII.  

 

ARPE Circularity 
 

PRPE Circularity 
 

ARPE/PRPE Circularity 

Factor p-value 
 

Factor p-value 
 

Factor p-value 

Concentration 0.069 
 

Concentration 0.000 
 

Type 0.002 

Gel(Conc) 0.317 
 

Gel(Conc) 0.007 
 

Concentration 0.000 

R-Sq(Adj) 0.0833 
 

R-Sq(Adj) 0.3769 
 

Gel(Conc) 0.027 

      
R-Sq(Adj) 0.2916 

TABLE IX -ANOVA for Circularity. Left- ARPE-19 groups. Center- PRPE groups. Right- ARPE vs. PRPE 

groups. Yellow indicates significance. 

 

 

ARPE Group 
 

PRPE Group 

5 A 
 

5 B 

10 A 
 

10 B 

20 A 
 

20 B 

FN A 
 

FN A 
TABLE X -Tukey’s Test for Circularity vs. Concentration. Letters indicate groups significant from one another. 

 

In general, the circularity values recorded for ARPE-19 cells show no significance 

between groups. PRPE groups for circularity also show significantly smaller values 

than fibronectin. This shows that RGDS does not significantly promote higher 
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circularity values than fibronectin itself. Further evaluation should help indicate if this 

trend of conveying dedifferentiation is also indicated through the rest of the parameters 

measured below.  

 

E. Determination of RPE Differentiation: ZO-1 Cell Perimeter 

 

Analysis of ZO-1 images also included obtaining cell perimeter values. The 

following data on cell perimeter was obtained from the analysis of ZO-1 images 

obtained from each group (Figure 15).  

 
FIGURE 15- Perimeter by Group. Bars indicate standard deviation. 

 

t-test ARPE Perim 
 

t-test PRPE Perim 
 

t-test 
 

Perim 

Group vs p-value 
 

Group vs p-value 
 

Group vs p-value 

5 10 0.214 
 

5 10 0.001 
 

A-5 P-5 0.330 

5 20 0.061 
 

5 20 0.065 
 

A-10 P-10 0.012 

5 FN 0.417 
 

5 FN 0.000 
 

A-20 P-20 0.013 

10 20 0.266 
 

10 20 0.000 
 

A-FN P-FN 0.001 

10 FN 0.286 
 

10 FN 0.124 
    20 FN 0.108 

 
20 FN 0.000 

    TABLE XI -Perimeter p-values Left- ARPE-19 groups. Center- PRPE groups. Right- ARPE vs. PRPE groups. 

Yellow indicates significance. 
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Of the data collected for ARPE-19 cells, no statistically significant difference was 

found between any of the samples, although the difference between 5 and 20µmol/mL 

is less than 0.07 (Table XI). This indicates that with increased statistical samples, the 

variability between these two groups may become significant. This observation may 

also be an indication that since ARPE-19s are an immortalized cell line, they may 

respond significantly different to substrate integrin concentrations. Although no 

statistically significant differences were found between ARPE-19 groups, the same 

cannot be said for PRPEs seeded on gels with different RGDS concentrations. All 

RGDS gel concentrations but 10mol/mL show significant differences from the 

fibronectin controls as well as a significant difference between 10 and 20µmol/mL and 

between 5 and 10µmol/mL. Interestingly, no significant difference is noted between 

these two paired groups for PRPE when measured for circularity. This may indicate 

that an increase in perimeter does not necessarily coincide or directly correlate with a 

fibroblastic morphology. This is shown in the reorganization of RPEs in vivo when 

cells begin to die with age. RPEs will tend to spread circumferentially to fill in small 

defects instead of becoming polarized (Grierson et al. 1994). 

A multi-factor ANOVA following the General Linear Model was also performed 

using Minitab 16 to observe significant differences between concentrations, gels and 

cell types. Three ANOVAs were performed; one ANOVA for each cell type as well as 

an ANOVA for all samples. These results are listed in Tables XII. Tukey’s Test for 

perimeter is also shown in Table XIII. 
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ARPE Perimeter 
 

PRPE Perimeter 
 

ARPE/PRPE Perimeter 

Factor p-value 
 

Factor p-value 
 

Factor p-value 

Concentration 0.269 
 

Concentration 0.000 
 

Type 0.005 

Gel(Conc) 0.090 
 

Gel(Conc) 0.099 
 

Concentration 0.000 

R-Sq(Adj) 0.0837 
 

R-Sq(Adj) 0.2111 
 

Gel(Conc) 0.163 

      
R-Sq(Adj) 0.1596 

TABLE XII -ANOVA for Perimeter. Left- ARPE-19 groups. Center- PRPE groups. Right- ARPE vs. PRPE 

groups. Yellow indicates significance. 

 

 

ARPE Group 
 

PRPE Group 

5 A 
 

5 A 

10 A 
 

10 B 

20 A 
 

20 A 

FN A 
 

FN B 
TABLE XIII -Tukey’s Test for Perimeter vs. Concentration. Letters indicate groups significant from one 

another. 

 

 

The ANOVA in Table XII also shows similar results as the t-tests above. PRPE 

concentration is shown to be significant factor in the ANOVA. Type and concentration 

are also shown to be significant with the ANOVA data including both cell types. 

Tukey’s Test with PRPEs shows that there are two significantly different groups, 5 and 

20µmol/mL as compared to 10µmol/mL and fibronectin, matching the significance 

shown between groups in Table XI.  

In general, perimeter values recorded for ARPE-19 cells also show minimal 

variation between groups with no specific trend with increasing RGDS concentration. 

PRPE groups also show similar data. This indicates that RGDS does not significantly 

promote a differentiated state related to a smaller perimeter. Again, further evaluation 

of the last two parameters should help convey if this trend of parameters demonstrating 

a dedifferentiated, fibroblastic morphology.  
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F. Determination of RPE Differentiation: ZO-1 Cell Area 

 

ZO-1 images were also measured for cellular area. The following data on cell area 

was obtained from the analysis of ZO-1 images for each group (Figure 16).  

 

 
FIGURE 16- Area by Group. Bars indicate standard deviation. 

 

t-test ARPE Area 
 

t-test PRPE Area 
 

t-test 
 

Area 

Group vs p-value 
 

Group vs p-value 
 

Group vs p-value 

5 10 0.120 
 

5 10 0.002 
 

A-5 P-5 0.070 

5 20 0.059 
 

5 20 0.017 
 

A-10 P-10 0.003 

5 FN 0.282 
 

5 FN 0.005 
 

A-20 P-20 0.030 

10 20 0.393 
 

10 20 0.000 
 

A-FN P-FN 0.001 

10 FN 0.267 
 

10 FN 0.432 
    20 FN 0.176 

 
20 FN 0.000 

    TABLE XIV -Area p-values. Left- ARPE-19 groups. Center- PRPE groups. Right- ARPE vs. PRPE groups. 

Yellow indicates significance. 

 

No statistical significance was observed for cell area in ARPE-19 cells, although 

groups 5 and 20µmol/mL was shown to be less than 0.06 (Table XIV). Increased cell 

sample measurements may potentially reduce this p-value, indicating significance 
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between these groups. For PRPE cells, 5 and 20 µmol/mL were found to be statistically 

different from fibronectin controls, whereas 10 umol/ml was not. Differences between 

each of the RGDS gel concentrations were also shown to be statistically significantly 

different. These findings further indicate that increasing RGDS concentrations does not 

significantly impact morphology. An increase in area is also typically associated with, 

in vivo, death and rearrangement of the RPEs (Grierson et al., 1994). Since these cells 

do not proliferate for small defects, their area increases to compensate for the reduction 

in cell density, which may correlate to the higher area values recorded for both cell 

types. 

A multi-factor ANOVA following the General Linear Model was also performed 

using Minitab 16 to observe significance between concentrations, gels and cell types. 

Three ANOVAs were performed; one ANOVA for each cell type as well as an 

ANOVA for all samples. These results are listed in Tables XV. Tukey’s Test for area is 

also shown in Table XVI. 

 

 ARPE Area 
 

PRPE Area 
 

ARPE/PRPE Area 

Factor p-value 
 

Factor p-value 
 

Factor p-value 

Concentration 0.368 
 

Concentration 0.000 
 

Type 0.000 

Gel(Conc) 0.108 
 

Gel(Conc) 0.053 
 

Concentration 0.003 

R-Sq(Adj) 0.0755 
 

R-Sq(Adj) 0.1793 
 

Gel(Conc) 0.098 

      
R-Sq(Adj) 0.1473 

TABLE XV -ANOVA for Area. Left- ARPE-19 groups. Center- PRPE groups. Right- ARPE vs. PRPE groups. 

Yellow indicates significance. 

 

ARPE Group 
 

PRPE Group 

5 A 
 

5 A 

10 A 
 

10 B 

20 A 
 

20 A 

FN A 
 

FN B 
TABLE XVI -Tukey’s Test for Area vs. Concentration. Letters indicate groups significant from one another. 
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The ANOVA in Table XV again shows comparable data as the t-tests above. 

PRPE concentration is shown to be a significant factor in the ANOVA, revealing 

statistically significant values recorded for RGDS concentration. Cell type and cell 

concentration were also significantly different for the ANOVA. Tukey’s Test with 

PRPEs shows that there are two significantly different groups, 5 and 20µmol/mL as 

compared to 10µmol/mL and fibronectin, similar to the significance shown between 

groups in Table XIV, although the t-tests indicate that 5 and 20µmol/mL are 

significantly different. This is due to differences in calculation of significance, but also 

shows that other factors may decrease the significance between groups, such as 

recorded individual gel variation.  

In general, area values recorded for ARPE-19 cells also show minimal variation 

between groups with no specific trend. PRPE groups show significance from other 

concentrations and controls, but no clear trend due to increasing concentration, 

revealing there may be other potential influences. This indicates that RGDS does not 

directly promote a differentiated state related to a smaller area, although further 

evaluation of the last parameter should help convey if the values previously shown truly 

display a dedifferentiated, fibroblastic morphology. 

 

G. Determination of RPE Differentiation: ZO-1 Aspect Ratio 

 

Finally, ZO-1 images were also measured for cellular aspect ratio. The following 

data on cell aspect ratio was obtained from the analysis of ZO-1 images obtained from 

each group (Figure 17).  
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FIGURE 17- Aspect Ratio by Group Bars indicate standard deviation. 

 

 

t-test ARPE Aspect 
 

t-test PRPE Aspect 
 

t-test    Aspect 

Group vs p-value 
 

Group vs p-value 
 

Group vs p-value 

5 10 0.377 
 

5 10 0.078 
 

A-5 P-5 0.021 

5 20 0.133 
 

5 20 0.003 
 

A-10 P-10 0.163 

5 FN 0.362 
 

5 FN 0.365 
 

A-20 P-20 0.045 

10 20 0.160 
 

10 20 0.022 
 

A-FN P-FN 0.022 

10 FN 0.438 
 

10 FN 0.033 
    20 FN 0.283 

 
20 FN 0.000 

    TABLE XVII-Aspect Ratio p-values. Left- ARPE-19 groups. Center- PRPE groups. Right- ARPE vs. PRPE 

groups. Yellow indicates significance. 

 

Again, no significant difference was found between any groups in ARPE-19 cells 

(Table VII). For PRPE, fibronectin controls were significantly different than the 10 and 

20 µmol/mL RGDS concentration groups, but not the 5 µmol/mL group. This shows 

that fibronectin controls promote the smallest aspect ratio, demonstrating a higher 

cellular surface density and potentially more differentiated state. The 20 µmol/mL 

group was also found to be significantly different than all other groups. This further 

indicates that other factors may be effecting morphology, since no proportional 

relationship is shown by increasing concentrations of RGDS.  
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Another interesting finding is the relationship of the 5 µmol/mL PRPE circularity 

and aspect ratio.  This group has the second lowest average circularity value and has the 

second lowest aspect ratio. For a perfect circle or shapes nearing a circular shape, a 

high circularity value as well as a low aspect ratio are recorded. This must mean that for 

this group cells are forming shapes other than the typical epithelioid-hexagon, such as a 

squared or triangular form. In contrast, PRPE fibronectin controls show an inverse 

relationship between aspect ratio (low) to circularity (high). This reveals the fibronectin 

controls are potentially promoting a more differentiated state. 

A multi-factor ANOVA following the General Linear Model was also performed 

using Minitab 16 to observe significance between concentrations, gels and cell types. 

Three ANOVAs were performed; one ANOVA for each cell type as well as an 

ANOVA for all samples. These results are listed in Tables XVIII. Tukey’s Test for 

aspect ratio is also shown in Table XIX.   

 

ARPE 
Aspect 
Ratio 

 
PRPE 

Aspect 
Ratio 

 
ARPE/PRPE 

Aspect 
Ratio 

Factor p-value 
 

Factor p-value 
 

Factor p-value 

Concentration 0.526 
 

Concentration 0.000 
 

Type 0.024 

Gel(Conc) 0.117 
 

Gel(Conc) 0.042 
 

Concentration 0.005 

R-Sq(Adj) 0.0397 
 

R-Sq(Adj) 0.1425 
 

Gel(Conc) 0.004 

      
R-Sq(Adj) 0.1283 

Table XVIII -ANOVA for Aspect Ratio. Left- ARPE-19 groups. Center- PRPE groups. Right- ARPE vs. PRPE 

groups. Yellow indicates significance. 

  

 

ARPE Group 
 

PRPE Group 

5 A 
 

5 BC 

10 A 
 

10 AB 

20 A 
 

20 A 

FN A 
 

FN C 
Table XIX Tukey’s Test for Aspect Ratio vs. Concentration. Letters indicate groups significant from one 

another. 
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The ANOVA in Table XVIII also shows similar results as the t-tests above. PRPE 

concentration is shown to be a significant factor in the ANOVA as well as the gel 

concentrations. Cell type, concentration and gel concentrations were also shown to be 

significantly different. The Tukey’s Test for the PRPEs shows that there are three 

significantly different groups, 10 and 20µmol/mL, 5 and 10µmol/mL and 5µmol/mL 

and fibronectin, , similar to the significance shown between groups in Table XVII. 

Although the data shows three significantly different groups, no correlation to 

increasing RGDS concentration is shown, indicating that these significances may be 

caused by other factors.  

Although ZO-1 measurements provide a quantifiable method for determining 

cellular differentiation and morphology based on visual parameters, the values obtained 

for both cell types indicate that the concentrations used for this study were insufficient 

in promoting epithelioid differentiation similar to fibronectin controls. This may 

potentially suggest that RGDS may be insufficient in itself to promote the desired 

morphology of these cells, requiring a combination of other peptides along with RGDS 

or the use of another adhesion ligand based peptide alone. Future research could 

potentially include the use of other fibronectin-based peptide sequences shown to 

enhance the use of RGDS, such as PHSRN (Feng et al., 2004). Other adhesive ligand 

based peptides may also be of interest, such as sequences based on collagen IV.  
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H. Determination of RPE Differentiation: Actin Filament Length and Orientation 

 

Actin filament distribution was also observed using immunocytochemistry 

techniques.  Samples were stained for rhodamine-phalloidin along with ZO-1 staining 

as mentioned above. Samples were then analyzed using confocal microscopy and 

imageJ software to observe the morphological characteristics of F-actin. This 

experiment was then repeated in order to obtain a sample size large enough to 

statistically analyze using Minitab 16. All Actin filament images are shown in 

Appendix III.  

In typical RPE morphology, actin filaments are strongly associated with tight 

junction formation around the perimeter of the cells.  As shown in Figure 22, typical 

actin expression is predominantly found in the same area as ZO-1 and other tight 

junction related proteins. As RPE cells become more dedifferentiated, the cells become 

more fibroblastic and express actin stress fibers as well as α-smooth muscle actin 

(Grierson et al., 1994).  

When analyzing actin for each group, large amounts of actin were found 

throughout the volume of the cell. This strongly indicates that stress-related fibers have 

been produced either due to substrate, soluble or spatially initiated cues. This also 

indicates the promotion of dedifferentiation into fibroblastic morphologies. These 

observations also correlate with the aberrant circularity and aspect ratio values obtained 

through ZO-1 measurements. The promotion of large amounts of intracellular actin also 

made the ability to distinguish circumferential actin extremely difficult, preventing 

accurate measurement of circumferential actin length and angle orientation to correlate 
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with ZO-1 circularity and aspect ratio values. Sample images are shown in Figure 18 

with the left image being PRPE cells on fibronectin. On the top 1/3 of the image, 

appropriate actin morphology is shown, but only for a few cells. In the same image 

towards the lower half, an increase in actin is expressed, making cellular boundaries 

indistinguishable. The right image shows ARPE-19 cells on fibronectin; however, the 

cell boundaries are indistinguishable in the entire image, making actin length and 

orientation measurements based on individual cell shape unobtainable.  

Figure 19 demonstrates an appropriate actin morphology when RPE cells are 

adequately differentiated (Lee 2007). Using this morphology, actin length and 

orientation can be determined and shown to correlate with ZO-1 circularity and aspect 

ratio values. Actin lengths should be roughly equal on all sides and have a near 

horizontal distribution of angles between 0 and 180 degrees when cells are adequately 

differentiated. Any increase in the average length or change in variation from a normal 

angle distribution would indicate a shift toward a fibroblastic morphology due to the 

increasing polarity of the cells. A significant increase in intracellular actin expression 

would suggest a shift to a dedifferentiated state for the cell, as illustrated in the images 

obtained in this study.  
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FIGURE 18- Actin Expression on Fibronectin controls. Left- PRPE FN 2-2 Right- ARPE FN 1-4 

 

 

 
FIGURE 19- Actin Expression in Differentiated RPEs (acquired from Lee 2007) 
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V. CONCLUSIONS 

 

Four specific aims were analyzed for the duration of this research. First, the 

technique for surface modification of PEG hydrogels with PEG-RGDS adhesion 

ligand was quantified using AlexaFluor 488 conjugated PEG-RGDS. This study found 

that between four and five percent of the total PEG-RGDS solution was polymerized 

on the surface for each gel group. This showed the functionality of the technique as 

well as providing a range of adhesion ligand concentration to correlate with cell 

confluency values for a later specific aim. Further analysis of the fluorescently coated 

gels using confocal microscopy also proved statistical significance between all coating 

concentrations except for 10 and 20 µmol/mL. It was also shown that the peptide layer 

is homogeneous throughout the surface of each gel.  

For the second specific aim, cellular confluency was compared on differing 

concentrations of adhesion ligands on PEG hydrogels and compared to non-coated 

PEG gels and fibronectin coated coverslips. Of the two cell types, only one group was 

found to be statistically significant from the fibronectin control; the 10 µmol/mL 

ARPE-19 group. This statistical significance could be caused by the lack of bare gel 

observed in the fibronectin controls, but should still be considered when trying to 

optimize the concentration of adhesion ligand for this cell type.  All groups of both 

cell types were also found to be statistically significant from the negative control gels. 

This shows that in terms of cellular adhesion, the entire range of concentrations could 

potentially be used for both cell types.  
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In terms of differentiated RPE morphology, experimental data showed different 

results compared to confluency in terms of appropriate concentration of adhesion 

peptide. In general for ZO-1 studies, low sample sizes in 5µmol/mL and fibronectin 

controls in the ARPE-19 studies only seemed to affect results by reducing the variation 

seen between gels, preventing a visible significant difference between groups. All four 

parameters also showed statistical significance between cell types, indicating that both 

of these cell types do not respond identically to one another.  

Images taken for R-P were unable to be appropriately analyzed for 

circumferential actin length and angle compared to ZO-1 due to significant amounts of 

intracellular actin expression typically only expressed by fibroblastic type RPEs. This 

shows that both cell types in all groups were expressing some indicators for 

fibroblastic dedifferentiation.  

In conclusion, although the studied levels of PEG-RGDS allowed for near 

confluent levels of RPE cells on PEG hydrogels, cellular circularity, area, perimeter 

and aspect ratio did not seem to be related in any proportion to RGDS surface 

concentration. Fibronectin controls in all cases indicated the closest epithelial 

morphology based on ZO-1 expression. Other conditions may be potential factors that 

allow RPEs to become dedifferentiated, such as spatial distribution, material stiffness 

or lack of certain factors that promote differentiation. In conclusion, the hypothesis 

that increasing concentrations of PEG-RGDS on PEG-DA hydrogels will significantly 

promote morphological expression tied to RPE-specific differentiation in both ARPE-

19 and primary PRPE cell lines was found to be false based on the results of this 

research.  
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VI. RECOMMENDATIONS 

 

Additional work will be needed in order to fully characterize the state of 

differentiation for RPE cells seeded on PEG-RGDS coated hydrogels. Factors such as 

RPE 65 and cellular retinaldehyde binding protein can be stained using similar 

immunocytochemistry techniques to obtain differentiation information, since these 

factors are only produced when these cells are in a differentiated state.  

In general, more research must be conducted in the promotion and sustainment of 

RPE cells of differentiated epithelial states after achieving confluency. Fibronectin and 

fibronectin-based layers have shown to promote excellent migratory and proliferative 

responses but do not seem to promote differentiation after achieving confluency based 

on the experimental results discussed above. Alteration of post-confluent media with 

compounds that promote differentiation may also prove to be beneficial if the end goal 

is to transplant a fully functioning sheet of cells on the hydrogel into the damaged area. 

As for using the currently developed material in the wound site to encourage migration 

and proliferation by existing RPEs, other factors may be required in order to promote a 

differentiated state after confluency is reached. These factors could be either substrate 

based, such as collagen or heparin sulfate or based on growth factors that are released 

after reaching confluency. Other peptides based on other functional domains of 

integrins could also be included to promote a differentiated state. Other peptide 

sequences from non-fibronectin based extracellular matrix proteins could also be used 

such as sequences from collagen IV.  Animal studies using PEG-RGDS coated 
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hydrogels should also be performed to evaluate the efficiency of proliferation and 

differentiation in vivo, since potential differentiation factors may be present in the body 

after confluency is reached and a semi-functioning RPE layer is established. In terms of 

encouraging differentiation, growth factor ‘pockets’ that release upon cell contact or 

PEG acrylate modified growth factors that promote RPE differentiation could be 

included within the gel. Further work must then be conducted to ensure adequate repair 

of the adjacent neuronal layer as well as the choricocapillaris in order to restore all 

tissue layers to their normal, functioning state.  
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APPENDIX I: Gel Concentration Quantification Images 

 

 

 

All images follow the same naming format: 

 

Gel-(Concentration)-(Gel Number)-(Image Number) 

 

All quantification images are taken at 60x.  
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FIGURE A1.1- Gel 0-1-1 

 

 

FIGURE A1.2- Gel 0-2-1 
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FIGURE A1.3- Gel 0-3-1 

 

 

FIGURE A1.4- Gel 0-4-1 
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FIGURE A1.5- Gel 5-1-1 

 

 

FIGURE A1.6- Gel 5-2-1 
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FIGURE A1.7- Gel 5-3-1 

 

 

FIGURE A1.8- Gel 5-4-1 
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FIGURE A1.9- Gel 10-1-1 

 

 

FIGURE A1.10- Gel 10-2-1 
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FIGURE A1.11- Gel 10-3-1 

 

 

FIGURE A1.12- Gel 10-4-1 
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FIGURE A1.13- Gel 20-1-1 

 

 

FIGURE A1.14- Gel 20-2-1 
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FIGURE A1.15- Gel 20-3-1 

 

 

FIGURE A1.16- Gel 20-4-1 
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APPENDIX II: Gel Confluency Images 

 

 

All images follow the same naming format: 

 

(Cell Type) (Concentration)-(Gel Number)-(Image Number) 

 

All quantification images are taken at 60x. 

 

Solid black images represent complete (100%) cellular coverage. 
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FIGURE A2.1- ARPE 0-1-1 Confluency  

 

 

 

 



 

93 

 

 

FIGURE A2.2- ARPE 0-1-2 Confluency  
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FIGURE A2.3- ARPE 0-1-3 Confluency  
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FIGURE A2.4- ARPE 0-2-1 Confluency  
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FIGURE A2.5- ARPE 0-2-2 Confluency  
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FIGURE A2.6- ARPE 0-2-3 Confluency  
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FIGURE A2.7- ARPE 0-3-1 Confluency  
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FIGURE A2.8- ARPE 0-3-2 Confluency  
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FIGURE A2.9- ARPE 0-3-3 Confluency  
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FIGURE A2.10- ARPE 5-1-1 Confluency  
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FIGURE A2.11- ARPE 5-1-2 Confluency  
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FIGURE A2.12- ARPE 5-1-3 Confluency  

 

 

 



 

104 

 

 

FIGURE A2.13- ARPE 5-2-1 Confluency  
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FIGURE A2.14- ARPE 5-2-2 Confluency  
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FIGURE A2.15- ARPE 5-2-3 Confluency  
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FIGURE A2.16- ARPE 5-3-1 Confluency  
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FIGURE A2.17- ARPE 5-3-2 Confluency  
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FIGURE A2.18- ARPE 5-3-3 Confluency  
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FIGURE A2.19- ARPE 10-1-1 Confluency  
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FIGURE A2.20- ARPE 10-1-2 Confluency  
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FIGURE A2.21- ARPE 10-1-3 Confluency  
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FIGURE A2.22- ARPE 10-2-1 Confluency  
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FIGURE A2.23- ARPE 10-2-2 Confluency  
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FIGURE A2.24- ARPE 10-2-3 Confluency  
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FIGURE A2.25- ARPE 10-3-1 Confluency  

 

 

 



 

117 

 

 

FIGURE A2.26- ARPE 10-3-2 Confluency  
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FIGURE A2.27- ARPE 10-3-3 Confluency  
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FIGURE A2.28- ARPE 20-1-1 Confluency  
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FIGURE A2.29- ARPE 20-1-2 Confluency  
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FIGURE A2.30- ARPE 20-1-3 Confluency  
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FIGURE A2.31- ARPE 20-2-1 Confluency  
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FIGURE A2.32- ARPE 20-2-2 Confluency  
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FIGURE A2.33- ARPE 20-2-3 Confluency  
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FIGURE A2.34- ARPE 20-3-1 Confluency  
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FIGURE A2.35- ARPE 20-3-2 Confluency  

 

 

 



 

127 

 

 

FIGURE A2.36- ARPE 20-3-3 Confluency  
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FIGURE A2.37- ARPE FN-1-1 Confluency 
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FIGURE A2.38- ARPE FN-1-2 Confluency 
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FIGURE A2.39- ARPE FN-1-3 Confluency 
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FIGURE A2.40- ARPE FN-2-1 Confluency 
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FIGURE A2.41- ARPE FN-2-2 Confluency 
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FIGURE A2.42- ARPE FN-2-3 Confluency 
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FIGURE A2.43- ARPE FN-3-1 Confluency 

 

 

 



 

135 

 

 

FIGURE A2.44- ARPE FN-3-2 Confluency 
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FIGURE A2.45- ARPE FN-3-3 Confluency 
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FIGURE A2.46- PRPE 0-1-1 Confluency 
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FIGURE A2.47- PRPE 0-1-2 Confluency 
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FIGURE A2.48- PRPE 0-1-3 Confluency 
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FIGURE A2.49- PRPE 0-2-1 Confluency 
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FIGURE A2.50- PRPE 0-2-2 Confluency 
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FIGURE A2.51- PRPE 0-2-3 Confluency 
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FIGURE A2.52- PRPE 0-3-1 Confluency 
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FIGURE A2.53- PRPE 0-3-2 Confluency 
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FIGURE A2.54- PRPE 0-3-3 Confluency 
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FIGURE A2.55- PRPE 5-1-1 Confluency 
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FIGURE A2.56- PRPE 5-1-2 Confluency 
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FIGURE A2.57- PRPE 5-1-3 Confluency 
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FIGURE A2.58- PRPE 5-2-1 Confluency 
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FIGURE A2.59- PRPE 5-2-2 Confluency 
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FIGURE A2.60- PRPE 5-2-3 Confluency 
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FIGURE A2.61- PRPE 5-3-1 Confluency 
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FIGURE A2.62- PRPE 5-3-2 Confluency 
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FIGURE A2.63- PRPE 5-3-3 Confluency 
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FIGURE A2.64- PRPE 10-1-1 Confluency 
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FIGURE A2.65- PRPE 10-1-2 Confluency 
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FIGURE A2.66- PRPE 10-1-3 Confluency 
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FIGURE A2.67- PRPE 10-2-1 Confluency 
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FIGURE A2.68- PRPE 10-2-2 Confluency 
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FIGURE A2.69- PRPE 10-2-3 Confluency 
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FIGURE A2.70- PRPE 10-3-1 Confluency 
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FIGURE A2.71- PRPE 10-3-2 Confluency 
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FIGURE A2.72- PRPE 10-3-3 Confluency 
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FIGURE A2.73- PRPE 20-1-1 Confluency 
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FIGURE A2.74- PRPE 20-1-2 Confluency 
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FIGURE A2.75- PRPE 20-1-3 Confluency 
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FIGURE A2.76- PRPE 20-2-1 Confluency 
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FIGURE A2.77- PRPE 20-2-2 Confluency 
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FIGURE A2.78- PRPE 20-2-3 Confluency 
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FIGURE A2.79- PRPE 20-3-1 Confluency 
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FIGURE A2.80- PRPE 20-3-2 Confluency 
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FIGURE A2.81- PRPE 20-3-3 Confluency 
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FIGURE A2.82- PRPE FN-1-1 Confluency 
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FIGURE A2.83- PRPE FN-1-2 Confluency 
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FIGURE A2.84- PRPE FN-1-3 Confluency 
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FIGURE A2.85- PRPE FN-2-1 Confluency 
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FIGURE A2.86- PRPE FN-2-2 Confluency 
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FIGURE A2.87- PRPE FN-2-3 Confluency 
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FIGURE A2.88- PRPE FN-3-1 Confluency 
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FIGURE A2.89- PRPE FN-3-2 Confluency 
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FIGURE A2.90- PRPE FN-3-3 Confluency 
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APPENDIX III: Confocal Microscopy Images 

 

 

All images follow the same naming format: 

 

(Cell Type) -(Concentration)-(Gel Number)-(Image Number)  (Date Taken) 

 

All images are taken at 60x. 

 

Top left: Composite image 

Top right: Actin Staining 

Bottom Left: DAPI staining 

Bottom Right: ZO-1 staining 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

183 

 

 

FIGURE A3.1- ARPE 0-1-1 (5/10/13) 
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FIGURE A3.2- ARPE 0-2-1 (5/10/13) 
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FIGURE A3.3- ARPE 0-3-1 (6/7/13) 
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FIGURE A3.4- ARPE 0-4-1 (6/7/13) 
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FIGURE A3.5- ARPE 5-1-1 (5/10/13) 
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FIGURE A3.6- ARPE 5-1-1 ZO-1 Analysis 
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FIGURE A3.7- ARPE 10-1-1 (5/10/13) 
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FIGURE A3.8- ARPE 10-1-1 ZO-1 Analysis 
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FIGURE A3.9- ARPE 10-2-1 (5/10/13) 
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FIGURE A3.10- ARPE 10-2-1 ZO-1 Analysis 
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FIGURE A3.11- ARPE 20-1-3 (5/10/13) 
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FIGURE A3.12- ARPE 20-1-3 ZO-1 Analysis 
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FIGURE A3.13- ARPE 20-2-1 (5/10/13) 

 

 

 

 

 

 

 

 

 

 

 

 



 

196 

 

 

FIGURE A3.14-ARPE 20-2-1 ZO-1 Analysis 
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FIGURE A3.15- ARPE FN-1-4 (6/7/13) 
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FIGURE A3.16- ARPE FN-1-4 ZO-1 Analysis 
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FIGURE A3.17- ARPE FN-3-1 (6/7/13) 
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FIGURE A3.18- ARPE FN-3-1 ZO-1 Analysis 
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FIGURE A3.19- ARPE FN-4-1 (6/7/13) 
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FIGURE A3.20- ARPE FN-4-1 ZO-1 Analysis 

 

 

 

 

 

 

 

 

 

 



 

203 

 

 

FIGURE A3.21- PRPE 0-1-1 (5/17/13) 
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FIGURE A3.22- PRPE 0-2-1 (5/17/13) 
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FIGURE A3.23- PRPE 0-3-1 (6/1/13) 
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FIGURE A3.24- PRPE 0-4-1 (6/1/13) 
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FIGURE A3.25- PRPE 5-1-1 (5/17/13) 
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FIGURE A3.26- PRPE 5-1-1 ZO-1 Analysis 
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FIGURE A3.27- PRPE 5-2-1 (5/17/13) 
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FIGURE A3.28- PRPE 5-2-1 ZO-1 Analysis 
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FIGURE A3.29- PRPE 5-3-1 (6/1/13) 
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FIGURE A3.30- PRPE 5-3-1 ZO-1 Analysis 
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FIGURE A3.31- PRPE 10-1-1 (5/17/13) 
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FIGURE A3.32- PRPE 10-1-1 ZO-1 Analysis 
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FIGURE A3.33- PRPE 10-2-1 (5/17/13) 
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FIGURE A3.34- PRPE 10-2-1 ZO-1 Analysis 

 

 

 

 

 

 

 

 

 

 



 

217 

 

 

FIGURE A3.35- PRPE 10-3-1 (6/1/13) 
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FIGURE A3.36- PRPE 10-3-1 ZO-1 Analysis 
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FIGURE A3.37- PRPE 10-4-1 (6/1/13) 
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FIGURE A3.38- PRPE 10-4-1 ZO-1 Analysis 
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FIGURE A3.39- PRPE 20-1-1 (5/17/13) 
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FIGURE A3.40- PRPE 20-1-1 ZO-1 Analysis 
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FIGURE A3.41- PRPE 20-1-3 (6/1/13) 
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FIGURE A3.42- PRPE 20-1-3 ZO-1 Analysis 
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FIGURE A3.43- PRPE 20-3-1 (6/1/13) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

226 

 

 

FIGURE A3.44- PRPE 20-3-1 ZO-1 Analysis 
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FIGURE A3.45- PRPE FN-1-1 (5/17/13) 
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FIGURE A3.46- PRPE FN-1-1 ZO-1 Analysis 
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FIGURE A3.47- PRPE FN-2-1 (5/17/13) 
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FIGURE A3.48- PRPE FN-2-1 ZO-1 Analysis 
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FIGURE A3.49- PRPE FN-1-2 (6/1/13) 
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FIGURE A3.50- PRPE FN-1-2 ZO-1 Analysis 
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FIGURE A3.51- PRPE FN-2-2 (6/1/13) 
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FIGURE A2.52- PRPE FN-2-2 ZO-1 Analysis 
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